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About E-Mail Connection
Welcome to E-Mail Connection. We are proud to provide you with this exciting product designed to keep 
you in touch with all your friends and business associates.

With E-Mail Connection you can:

· Choose your user interface mode--Easy Mode for novices, Power Mode for users who are more 
familiar with Windows and e-mail

· Send and receive electronic mail

· Address mail without memorizing cryptic address formats

· Reply to and forward any message you receive

· Send and receive one or more files attached to an e-mail message

· Automate pick-up and delivery of your electronic mail

· Print your messages

· Store, organize and file messages in an easy-to-use Folder system

· Add names to your Address Book automatically

· Let other users setup and maintain separate mailboxes and preferences

· Continue to work in your other windows applications while E-Mail Connection uploads or 
downloads messages or application files



About ConnectSoft

ConnectSoft, founded in January 1988, currently employs more than 130 people in its Bellevue and 
Kirkland offices in Washington.    ConnectSoft operates three divisions (Consumer Online Products and 
Services, Commercial Software Development Services, and Commercial Network Services) that are each
highly regarded for their innovative solutions and cutting edge technologies.
Through its Consumer Online Products and Services division, the company markets a family of Windows-
based telecommunication programs known as "Desktop Connections" for accessing on-line information 
services.    ConnectSoft's flagship product, E-Mail Connection, supports most online services and all 
major local area network messaging protocols, and includes fax and postal message delivery.    In addition
to E-Mail Connection, ConnectSoft publishes Internet Connection, KidMail Connection, Clip-Art 
Connection and Font Connection. Registered users of these ConnectSoft products are the first to be 
informed of new products and upgrades.

ConnectSoft's Commercial Software Development Services division provides consulting software 
development services to commercial PC software publishers, peripheral manufacturers, and Fortune 
1000 clients.    (For more information, please see our home page:    
HTTP://WWW.CONNECTSOFT.COM).

ConnectSoft recently created a new division, Commercial Network Services, in order to develop high 
quality, commercial Internet and TCP/IP services.

ConnectSoft Address:    11130 NE 33rd Place, Suite 250, Bellevue, WA, 98004.

ConnectSoft Phone:    206-827-6467
ConnectSoft Fax:    206-822-9095
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Hardware Requirements
E-Mail Connection requires the following hardware:

· A personal computer with an 80386-class processor (or higher)

· At least 4MB of RAM (8MB recommended)

· A hard disk drive with 7MB of free disk space

· Almost any popular modem (for connecting to the Internet via modem)

Related Topics:
Software Requirements
Modem and Network Services Requirements



Software Requirements
E-Mail Connection requires the following software:

· MS-DOS version 3.1 or later

· Microsoft Windows version 3.1 or later

Related Topics:
Hardware Requirements
Modem and Network Services Requirements



Modem and Network Services Requirements
To send e-mail using E-Mail Connection, you must have an e-mail account with an Internet service 
provider if you are using a SLIP/PPP connection. You can also use E-Mail Connection over a TCP/IP 
network connection.To use E-Mail Connection with a local area network (LAN), your computer must 
already be connected to the network, and you must have a mailbox in the network post office. If you are 
not sure about your mailbox, ask your network administrator.

Related Topics:
Hardware Requirements
Software Requirements
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Installing E-Mail Connection
To install E-Mail Connection, use the Setup program. Setup will copy the E-Mail Connection files to your 
hard drive.

1. Place the E-Mail Connection disk labeled Disk 1 in either drive A or B.

2. From the Program Manager window, select Run in the File menu.

3. In the Command Line box, type a:\setup.exe or b:\setup.exe, depending on which drive the E-
Mail Connection disk is in.

4. Press Enter.

5. Read the directions in the dialogs that follow and respond to the questions and prompts.

To cancel the installation, select the Cancel button in any of the installation dialogs. When you 
are ready to install E-Mail Connection, proceed as if it were your first time.

When you start E-Mail Connection for the first time, you will see the New User Information Dialog.



Starting E-Mail Connection
The E-Mail Connection icon appears inside of the Program Manager Group that you specified during 
installation. The default Program Manager Group is ConnectSoft.

To start E-Mail Connection, double-click the E-Mail Connection icon.

The first time you start E-Mail Connection, you will see the New User Information Dialog.



New User Information Dialog
The New User Information dialog appears the first time you start E-Mail Connection.

1. You must complete the Name box.

2. E-Mail Connection uses the information you provide in the Company box, the FAX Address 
dialog, and the Postal Address dialog during online registration.

3. Click the Set Password button if you want to secure your e-mail from others.
If you are not concerned about the security of your e-mail, ignore the Password option and click 
OK.



Set Password Dialog
The Set Password dialog appears when you click the Set Password button in the New User Information 
Dialog or the User Information Dialog. If you elect to set a password, access to your e-mail is limited to 
those who know your password.

To set a password:

1. Invent a word or a nonsensical string of characters that it is easy to remember and yet difficult to 
guess. There is little point using something as obvious as your name. If you have trouble 
remembering passwords, write your password down and keep it in a safe place.

2. Type the password in the Password text box in the Set Password dialog.

3. To ensure you have entered your password correctly, type the password again in the Password 
Match text box.

4. Click OK or press Alt + O.

From now on, E-Mail Connection will prompt you for your password in the User Login Dialog at the 
beginning of each E-Mail Connection session. To change your password, see Change Password Dialog

Related Topic:
How many characters may my password have?



Registration
Be sure to register your copy of E-Mail Connection with ConnectSoft. Registered users are always the 
first to receive information and product updates from ConnectSoft. 

Registering Online 



Registering Online
The Online Registration dialog lets you register your copy of E-Mail Connection with ConnectSoft via e-
mail.

1. Open the Online Registration dialog by selecting About E-Mail Connection in the Help menu.

2. Click the Register Now button.

3. Check the user information in the Online Registration dialog. This information includes the postal 
address that you entered in the New User Information dialog. If anything is incorrect, click the 
Modify button, make your corrections, and then click the OK button.

4. When you are sure the information is correct, click the Register Now button.

E-Mail Connection places your registration information in your Outbox as an e-mail message to 
ConnectSoft. The next time you log on to send mail, your registration form is sent.



Setting Up Multiple Users
Several users can share one copy of E-Mail Connection in the same way a household or an office shares 
a postal mailbox. Each user sets up a password to ensure privacy, and each user has a separate 
database.

To add, delete, or modify E-Mail Connection users, select Manage Users in the File menu. 

Note that since each user must log in separately (with or without a Password at the discretion of the user),
there is no way to switch from one user to another without first exiting E-Mail Connection. Once you have 
exited, restart E-Mail Connection and complete the User Login dialog.

To add a user:

1. Click Add.
The Add User dialog appears.

2. Complete the User Name field.

3. Click OK.
E-Mail Connection adds the new User Name to the pick list in the Manage Users dialog and 
creates a new database for that user. Thus, the first time new users log in, they must first 
complete the New User Information dialog, then configure E-Mail Connection, and set their own 
preferences.

To delete a user:

1. In the Manage Users dialog, select the user and click Delete.
The Delete User dialog appears.

2. Type the user name in the Confirm User Name box and the user's password in the Confirm 
Password box.

Note When you delete a user from your system, you delete the Address Book and Message 
database associated with that user. Thus, you should be very sure that no important information 
is in that database before you delete the user.

3. Click OK.

Related Topics:
The User Login Dialog



Add User Dialog
The Add User dialog appears when you click the Add button in the Manage Users dialog.

Type the name of the person you want to add in the User Name box, then click OK. The new name 
appears in the Manage Users dialog.

Note:
E-Mail Connection creates a new database for each new user you add. Thus, the first time a new user 
logs in, they must first complete the New User Information dialog, complete the configuration dialogs, and 
set their own preferences.



Customizing E-Mail Connection
The Preferences dialog makes it easy to customize E-Mail Connection;    change the look of your desktop 
by selecting new fonts and background patterns, change the default settings for sending, receiving, 
forwarding, deleting and replying to messages.

To open the Preferences dialog, select Preferences in the File menu.

A dialog with eight vertical Tabs will appear.

All of the options toggle off and on. If an option is checked, select it to erase the check mark;    selecting it 
a second time will turn it back on again. The Tabs are listed below in alphabetical order.

Confirmation Tab
Display Tab
Drafts Tab
Fonts Tab
New Mail Tab
Spell Check Tab
Trash Tab
Wallpaper Tab



Preferences Tabs
Please Note:
All default settings are indicated below by an asterisk (*).

Confirmation Tab
Require Password to Restore When you minimize E-Mail 

Connection as an icon, it continues to
send, scan for, and receive mail as 
scheduled.
The Require Password to Restore 
option lets you lock E-Mail 
Connection as an icon that no one 
can restore (i.e., read your mail) 
unless they know your Password. 

*Send Status Confirmation Inform you, when you send a 
message, that your message has 
been successfully placed in your 
Outbox.

*Forward Confirmation Display the Forward dialog when you
forward a message in order to 
override the defaults you set in the 
Preferences dialog.

*Reply Confirmation Display the Reply dialog when you 
reply to a message in order to 
override the defaults you set in the 
Preferences dialog.

Delete Message Options

*Move to Trash Move all messages you delete in the 
future to the Trash Folder. The 
advantage of using the Trash Folder 
is that you can recover a message 
later on if you need to.

Delete from database Erase all messages you delete in the 
future from your database.

*Delete Confirmation Display the Confirm Delete dialog in 
order to prevent an accidental 
deletion of an important message.

Display Tab
Please Note:
All default settings are indicated below by an asterisk (*).

*Smart Text Wrapping Remove any extraneous carriage 
returns from your incoming mail 
so that the message text wraps 
smoothly in your Message and 
Folder windows. The option is 



particularly useful if you receive 
messages from terminal based e-
mail services such as the Internet 
that use a hard carriage return to 
represent a new line.

User Interface Mode

*Easy Switch E-Mail Connection to Easy
Mode in order to work with basic 
e-mail activities.

Enable Inbox Rules Gives the Easy Mode user the option
to let E-Mail Connection sort Inbox 
mail into one or more specified 
folders. E-Mail Connection conducts 
the rule-based sort based upon 
parameters set by the user in a 
simple template.

 
Power Switch E-Mail Connection to 

Power Mode in order to take 
advantage of Search capabilities, 
Inbox Rules, Multiple Document 
Interface, and other advanced 
features requested by the power 
user.

Show Tool Bar Display/Hide the Power Modes main 
tool bar.

Show Window Bar Display/Hide the Window Bar in 
Power Mode. The Window Bar 
displays an icon for each open 
window on your desktop. If you hide 
the Window Bar, only your minimized 
windows will appear as icons at the 
bottom of your desktop.
For more information, please see The
Window Bar.

Show Status Bar Display/Hide the Status Bar in Power 
Mode. The Status Bar contains a brief
summary of the currently selected 
menu command.

Drafts Tab
Please Note:
All default settings are indicated below by an asterisk (*).

*Keep Copy Create a copy of every message you 
send and place it in the Sent Mail 
Folder.



*Prefix Forwarded Messages Mark the text of the original message 
in your forwarded message with the 
greater than symbol (i.e., >). The 
marks make it easy to distinguish 
your comments from the original 
message.

 
Reply Message Options

*Reply to Sender Only Address your reply to the person who
sent the original message.

Reply to All Recipients Address your reply to every person 
who received the original message.

*Include Original Message Copy the contents of the original 
message into the body of your reply. 
Including the original message in your
response helps to clarify the content 
of your reply and allows you to view 
the message as you write your 
response.

*Prefix Message Text Mark the text of the original message 
in your reply with the greater than 
symbol (i.e., >). The marks make it 
easy to distinguish your comments 
from the original message.

Message Headers Please see the Message Headers 
Dialog.

Fonts Tab
Please Note:
All default settings are indicated below by an asterisk (*).

E-Mail Connection distinguishes between two sets of fonts:

1. Application Fonts. Those fonts E-Mail Connection itself uses to write application information to 
your screen;      for example, Folder names.

2. Document Fonts. Those fonts you prefer when you type your drafts or view your messages.

Within each set, you may choose between:

1. Fixed Pitch Fonts. Those fonts, such as Terminal, whose letters remain a fixed distance apart.
If you receive a message from a terminal-based service such as the Internet, use a fixed pitch 
font to retain the original formatting of the message.

2. Proportional Fonts. Those fonts, such as Arial or Times New Roman, whose letters are placed a 
variable distance apart, depending upon the letter.

Application Font

Set Application Font Lets you modify the font that E-Mail 
Connection uses to write application 
information to your screen.



In the Choose Application Font 
dialog, select the Font, Font Style, 
and Size, then click OK.

Document Font

Set Fixed Pitch Font Lets you choose a Fixed Pitched font,
such as Terminal, whose letters 
remain a fixed distance apart.
If you receive a message from a 
terminal-based service such as the 
Internet, use a fixed pitch font to 
retain the original formatting of the 
message.
When you want to use a fixed pitch 
font to read your e-mail and write 
your messages, E-Mail Connection 
will use the font, font style, and point 
size you select in the Choose 
Document Fixed Pitch Font dialog.

Set Proportional Font Lets you choose a Proportional Font, 
such as Arial or Times New Roman, 
whose letters are placed a variable 
distance apart, depending on the 
letter.
When you want to use a proportional 
font to read your e-mail and write 
your messages, E-Mail Connection 
will use the font, font style, and point 
size you select in the Choose 
Proportional Font dialog.

Default Document Font

Fixed Pitch Of the two Document Fonts you 
chose above, you prefer to view the 
Fixed Pitch font in most cases.

*Proportional Of the two Document Fonts you 
chose above, you prefer to view the 
Proportional font in most cases.

New Mail Tab
Please Note:
All default settings are indicated below by an asterisk (*).

*Notify on New Mail Inform you when you receive new 
mail, and how many messages there 
are in your Inbox.

*Auto add to Address Book Check the sender's address with 
each new message you receive and 
automatically add it to your Address 
Book if it is not already listed.



Select *Sender Only to add just the 
sender's address.
Select Sender and All Recipients to 
add the addresses of any and all 
recipients of a message in addition to 
the sender's address.

Sort Inbox by Priority Place messages sent Priority Mail at 
the top of your Inbox.
By default, E-Mail Connection sorts 
the mail in your Inbox by date, with 
the most recent mail at the top.
Note:    The Sort Inbox by Priority 
option applies only to the Inbox;    not 
your other folders.

Spell Check Tab
Please Note:
All default settings are indicated below by an asterisk (*).

Spell Checker Options

Automatically spell check. . . After you click Send in a Draft 
window, the spell checker will scan 
your draft for spelling errors.

*Always Suggest Have the spell checker display a list 
of alternative spellings when it finds 
an error.

*Ignore words with numbers Have the spell checker skip over 
words such as 17'th or 486DX2/50. 

*Ignore words in upper case Have the spell checker ignore text 
such as C:\WINDOWS.

Trash Tab
Please Note:
All default settings are indicated below by an asterisk (*).

When Emptying Trash

*Delete all messages Delete all messages and drafts in the 
Trash Folder when you empty the 
trash.

Delete messages older 
than. . .days

Specify the number of days old a 
message or draft must be for E-Mail 
Connection to delete it when you 
empty the trash.

Emptying Trash

Empty trash after each use Automatically empty your trash after 
each E-Mail Connection session.



Empty trash now Empty your trash immediately.
When you do, the Trash message 
box appears.
Click Yes. Selecting No will return 
you to the Preferences dialog without
emptying your trash.

Wallpaper Tab
Please Note:
All default settings are indicated below by an asterisk (*).

By default, your E-Mail Connection desktop has a single bitmap placed in the center. You can remove the 
background pattern (i.e., the wallpaper) on your desktop, or modify it using any .BMP file available to you.

Wallpaper Options

*Tiled Repeats the bitmap until it covers the 
desktop.

Centered Positions the bitmap in the center of 
the desktop.

None Removes the bitmap from your 
desktop.

Current Wallpaper The name of the bitmap you last 
selected to appear on your desktop.

Set Wallpaper Change the bitmap displayed on your
desktop.
When you click Set Wallpaper, the 
Select Wallpaper Bitmap dialog 
appears.
Select a directory in the Directories 
list box, then choose a bitmap in the 
directory.
Or type a full path for the bitmap in 
the Source File Name box.
Click OK.
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About the Address Book
E-Mail Connection can only send messages to people or groups whose addresses are listed in your 
Address Book. If you try to send a message to an unlisted recipient, E-Mail Connection asks you if you 
want to add the recipient to your Address Book. Once you have added addresses to your Address Book, 
E-Mail Connection takes care of the complicated addressing process for you;    addressing your mail is as 
easy as typing the recipient's name.

There are two additional ways to add an address to your Address Book. 

· Add it manually. For more information, see Adding Addresses. 

· Select the Auto Add option available in Preference's New Mail Tab. This option automatically 
adds the address of a new sender to your Address Book.



Add Address Dialog
Before adding addresses, your Address Book must be open . To open your Address Book in Easy Mode, 
click the Address button on the main window tool bar. In Power Mode, open your Address Book by 
double-clicking the Address Book icon.

To add an address, click the Add button.

· Select Individual Address to add an individual address to your Address Book.

· Select Personal Mailing List to add a personal mailing list to your Address Book.

Click the OK button.

Related Topics:
Deleting Addresses 

Modifying Addresses.



Address Book Entry Selection
Easy Mode and Power Mode have different Address Book Entry Dialogs. Which mode are you working 
in?

Easy Mode Address Book Entry Dialog

Power Mode Address Book Entry Dialog



Easy Mode Address Book Entry Dialog

The Address Book Entry dialog appears when you click Add or Modify in the Address Book. E-Mail 
Connection stores your recipient's name and other personal information here as well as a listing of all his 
or her destination addresses.

Type a name in the dialog's Name box.

· Click the E-Mail button to add an e-mail address. Select the e-mail system from the New Address 
Type dialog, then complete the Address dialog.

· Click the Facsimile button to add a fax address, then complete the Fax Address Dialog.

· Click the Postal Address button to add a postal address, then complete the Postal Address 
Dialog.

The most important destination address is your recipient's default destination address. It is this address 
that E-Mail Connection automatically appends to your recipient's name in the To field of the Draft Window.
In other words, E-Mail Connection automatically sends your messages to your recipient at his or her 
Default Destination until you change the default to a different address.

Related Topics:
Deleting Addresses 

Modifying Addresses.



Power Mode Address Book Entry Dialog

The Address Book Entry dialog appears when you click Add or Modify in the Address Book. E-Mail 
Connection stores your recipient's name and other personal information here as well as a listing of all his 
or her destination addresses.

Selecting a destination address from the Address Types list box produces a dialog with the name of the 
destination in its title bar. It is in this dialog that you enter your recipient's address for the selected 
destination.

The most important destination address is your recipient's default destination address. It is this address 
that E-Mail Connection automatically appends to your recipient's name in the To field of the Draft Window.
In other words, E-Mail Connection automatically sends your messages to your recipient at his or her 
Default Destination until you change the default to a different address.

Finally, note that there is ample room to save extensive remarks about each recipient in the Comments 
memo field.

Related Topics:
Deleting Addresses

Modifying Addresses



Personal Mailing List Dialog
The Personal Mailing List dialog lets you create mailing lists that provide you with a simple way to 
address a group of two or more persons. When you want to send a message to everyone in the group, 
you type the name of the appropriate Personal Mailing List in the To field of the Draft Window.

The Personal Mailing List dialog appears when you click the Add button in your Address Book, then 
select Personal Mailing List in the Add Address dialog. 

To complete the dialog:

1. Type a name for the Personal Mailing List in the List Name box. Feel free to use any combination 
of characters.
Use the Comments field for general remarks or reminders to yourself about specific members or 
about the group itself.

2. Under Address Book, E-Mail Connection lists every addressee to whom you have assigned a 
valid e-mail address.

3. Select an entry and click Add or press Alt + A to add the entry to the Personal Mailing List.
The fastest way to find an entry is to type the first letter of his or her name on the keyboard.
For example, to find Mike Hammer, press M.
If you change your mind and want to remove an entry from the group, select it in the Group 
Members list box and click Remove or press Alt + R.

4. Repeat step 3 until your list is complete.

5. Click OK when your list is complete.

Related Topics:
Deleting Addresses

Modifying Addresses
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Forwarding a Message
Replying to a Message



Composing a Message
To compose a message, you need to be in the Draft window. 

1. Open the Draft window by clicking the Compose button on the main window tool bar or selecting 
New (Compose) in the Message menu.

2. Add recipients. There are two ways to add recipients to your message:

· Type the recipient's name in the To or cc (Courtesy Copy or Carbon Copy) box, and then 
press Enter or click the Return symbol. Repeat this process for all of the recipients.

· Click the Address button on the Draft window tool bar, select the recipient's name from the 
Address List, and then click the Add button. When you have added all of the recipients, click 
the OK button.

3. Type a topic for your message in the Subject box.

4. Type the body of your message in the lower field of the window.

5. Send the message by following the instructions for Sending a Message.

Related Topics:
Attaching a File to a Message

Deleting a Draft or a Message 

Message Handling

Pasting from a Text File 

Saving a Draft or a Message 

Mail System Schedule (Modem Services)

Mail System Schedule (Network Services)



Sending a Message
Sending a Message Over a Network

Sending a Message Over the Internet

Overriding the Mail System Schedule



Sending a Message Over a Network 
After you have written a message, send it by clicking the Send button on the Draft window tool bar. 

By default, E-Mail Connection will transmit the message immediately over your LAN. For more information
about scheduling network e-mail, see Mail System Schedule (Network Services).

Related Topics:
Message Handling
Overriding the Mail System Schedule



Sending a Message Over the Internet
To send a message:

1. Click the Send button on the Draft window tool bar.

E-Mail Connection will notify you that the "Message is queued to be sent," and place the message
in the Outbox. 

2. Connect to the Internet by clicking the Connect button, or wait for the Mail System Scheduler to 
connect to the Internet if you have set up a scheduled connection. Messages wait to be 
transmitted in the Outbox until the Mail System Scheduler picks them up or until you connect to 
your Internet provider. For more information about scheduling modem-based e-mail, see Mail 
System Schedule (Modem Services).

Related Topics:
Message Handling
Overriding the Mail System Schedule



Overriding the Mail System Schedule
If you have set up E-Mail Connection to transmit messages at a certain time or interval but want to 
transmit a particular message immediately:

· Click the Connect button on the main window tool bar.



Reading a Message
When you receive a message, it appears in your Inbox.

Your Inbox is the distribution center for all new messages. To open your Inbox, click the Inbox button or 
select Inbox in the Folder menu.

The Inbox lists the status, sender, subject, and date for each message. 

There are two ways to open a message from the Inbox:

· Double-click the message

· Select the message, and then click the Read button

Related Topics:
Copying a Message

Deleting a Draft or a Message

Exporting a Message

Forwarding a Message

Moving a Message

Opening a File Attachment

Printing a Message

Saving a Message

Scheduling (Network Service)

Scheduling (Modem Service)

Searching for a Message

Sorting Inbox Mail



Forwarding a Message
The Forward dialog appears when you click the Forward button.

· Prefix Message Text. Mark the text of the original message in your reply with the greater than 
symbol (i.e., >). The marks make it easy to distinguish your comments from the original message.

· Dont ask me in the future. Adopts the current setting as the default for all mail you forward in 
the future. In other words, if you select this option, you will not see the Forward dialog when you 
forward mail. If you change your mind and want the Forward dialog to appear when you forward 
mail, select Preferences in the File menu. A dialog with 8 vertical Tabs will appear. Click the 
Confirmation Tab, and toggle Forward Confirmation back on.

Click OK to open a Draft window and edit/send your forwarded message;    otherwise, click Cancel.

Related Topic:
Message Handling



Replying to a Message
As long as a message has not been deleted, you can reply to it any time.

To reply to a message:

1. Select the message from any Folder window.

2. Click the Reply button.

3. Select your reply options:

· Reply to Sender Only. Address your reply to the person who sent the original message.

· Reply to All Recipients. Address your reply to every person who received the original 
message.

· Include Original Message. Copy the contents of the original message into the body of your 
reply. Including the original message in your response helps to clarify the content of your 
reply and allows you to view the message as you write your response.

· Prefix Message Text. Mark the text of the original message in your reply with the greater 
than symbol (i.e., >). The marks make it easy to distinguish your comments from the original 
message.

· Dont ask me in the future. Adopts the current setting as the default for all mail you forward 
in the future. In other words, if you select this option, you will not see the Reply dialog when 
you reply to a message. If you change your mind and want the Reply dialog to appear when 
you reply to a message, click File from the menu bar and select Preferences. A dialog with 8 
vertical Tabs will appear. Click the Confirmation Tab, and toggle Reply Confirmation back 
on.

4. Click the OK button to open a Draft window and edit your reply;    otherwise, click the Cancel 
button.

5. Send the message by following the instructions for Sending a Message.

Related Topic:
Message Handling
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Creating a User Folder
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Deleting a User Folder
Renaming a User Folder



Creating a User Folder
When a new message arrives, it is automatically stored in the Inbox. If you stored all of your messages in 
the Inbox, a particular message might take a while to find. You can avoid this problem by creating folders 
that describe the subject, and storing your messages in them.

To create a user folder:

1. Select Create User Folder in the Folder menu.

2. Select one of your custom folders or the User folder to serve as a parent folder for your new 
folder.

3. Type a name for your new folder in the New User Folder Name box.

4. Click the OK button.

E-Mail Connection adds a new folder icon beneath the selected parent folder in the Folder List. 
The icon is clearly labeled with the name you assigned to the folder.

Related Topics:
Deleting a User Folder

Is there a limit to how many folders I can have?

Moving a Message

Renaming a User Folder



Moving a Message
After you have created one or more folders, you can continue organizing your desktop by moving 
messages and drafts into folders. Note You cannot move messages into the Inbox folder.

There are two ways to move a message:

· Select the message from any Folder window. Select Move in the Message menu, choose a 
destination folder in the Move Message dialog, and then click the OK button.

· Select the message. Drag and drop the message onto a folder.



Opening a Folder
To view the contents of a folder:

1. Click the Folders button (Easy Mode) or select New Folder Window (Power Mode) in the Folder 
menu if a Folder window is not open.

2. Click the folder you want to open.

Opening a Subfolder
To view the contents of a subfolder:

1. Double-click any folder with plus sign (+) on it to see the subfolders.

2. Click the folder you want to open.



Deleting a User Folder
The Delete User Folder dialog lets you delete one of your user folders. When you delete a folder you also 
delete its messages.

1. Open the Delete User Folder dialog by selecting Delete User Folder in the Folder menu. 

2. Select the folder to delete by clicking it.

3. Click the OK button.

To prevent accidental deletion of an important folder, E-Mail Connection prompts you to verify 
your intent to delete the folder with the Folder message box.

4. Click the OK button to complete deletion. If you change your mind, clicking Cancel will exit the 
dialog without deleting the folder.



Renaming a User Folder
The User Folder Properties dialog lets you rename one of your user folders. You cannot rename system 
folders.

1. Select the folder you want to rename from any Folder List.

2. Open the User Folder Properties dialog by selecting Rename User Folder in the Folder menu. 

3. Type a new name for the folder in the User Folder Name box.

4. Click the OK button. If you change your mind, clicking Cancel will exit the dialog without changing
the folder's original name.



How To...
Add an Address to your Address Book

Add a User

Attach a File to a Message

Change a Password

Compose a Message

Create a User Folder

Delete an Address from your Address Book

Delete a Draft or a Message

Delete a User Folder

Delete a User

Export a Message

Extract a File Attachment

Find a Message

Forward a Message

Install E-Mail Connection

Modify an Address in Your Address Book

Move a Message

Open a File Attachment

Open a Message

Print a Message

Read a Message

Register Your Product with ConnectSoft

Reply to a Message

Save a Draft or a Message

Schedule Modem Mail

Schedule Network Mail

Search for a Message

Select a Message

Send a Message

Set a Password

Sort Inbox Mail

Write a Message





Menus and Tool Bars
Menus

File Menu

Edit Menu

Message Menu

Folder Menu

Window Menu

Tool Bars
Main Window Tool Bar

Draft Window Tool Bar

Message Window Tool Bar

Folder Window Tool Bar



The File Menu
Easy Mode and Power Mode have different File Menus. Which mode are you working in?

Easy Mode

Power Mode



Easy Mode File Menu
E-Mail Connection stores information about you, your system, and your configuration preferences. To 
change this information, use the File Menu.

Select: To:

Manage 
Users
Alt + F, M

Add or delete an E-Mail 
Connection user. For more 
information, please see Setting 
Up Multiple Users.

User 
Information
Alt +F, U

Modify your user name, phone 
number, and password, as well 
as to add, modify, or delete 
information that appears under 
your name in your Address 
Book. For more information, 
please see the User 
Information Dialog.

Configure 
Mail
Alt + F, C

View or modify information 
concerning your email 
account(s), modem, mail 
schedule(s), etc.

Preferences
Alt + F, R

Set various system-wide 
defaults including mail, drafts, 
fonts, trash, display, spell 
check, etc. For more 
information, please see 
Preferences.

Export 
Messages
Alt + F, E

Export a copy of a message or 
a draft to a file on your hard 
disk. Export messages that are 
important or meaningful 
enough to save, but seem 
dated or inappropriate in your 
E-Mail Connection folders. For 
more information, please see 
Exporting Messages.

Print
Alt + F, P

Print a copy of the selected 
message(s) and/or draft(s). 
Before you print the first 
message in an E-Mail 
Connection session, it is a 
good idea to select Printer 
Setup in the File menu first and
check the current printer 
specifications. To check the 
current header and footer 



settings, select Page Setup in 
the File menu. For more 
information, please see Printing
a Message.

Page Setup
Alt + F, A

View or modify the current 
specifications set for the 
headers and footers that 
appear when you print a 
message or a draft. For more 
information, please see Page 
Setup.

Printer Setup
Alt + F, N

View or modify the current 
specifications set for the printer
or printer driver. For more 
information, please see Printer 
Setup.

Exit
Alt + F, X

Exit E-Mail Connection.



Power Mode File Menu
E-Mail Connection stores information about you, your system, and your configuration preferences. To 
change this information, use the File Menu.

Select: To:

Manage 
Users
Alt + F, M

Add or delete an E-Mail 
Connection user. For more 
information, please see Setting 
Up Multiple Users.

User 
Information
Alt +F, U

Modify your user name, phone 
number, and password, as well 
as to add, modify, or delete 
information that appears under 
your name in your Address 
Book. For more information, 
please see the User 
Information Dialog.

Preferences
Alt + F, R

Set various system-wide 
defaults including mail, drafts, 
fonts, trash, display, spell 
check, etc. For more 
information, please see 
Preferences.

Export 
Messages
Alt + F, E

Export a copy of a message or 
a draft to a file on your hard 
disk. Export messages that are 
important or meaningful 
enough to save, but seem 
dated or inappropriate in your 
E-Mail Connection folders. For 
more information, please see 
Exporting Messages.

Print
Alt + F, P

Print a copy of the selected 
message(s) and/or draft(s). 
Before you print the first 
message in an E-Mail 
Connection session, it is a 
good idea to select Printer 
Setup in the File menu first and
check the current printer 
specifications. To check the 
current header and footer 
settings, select Page Setup in 
the File menu. For more 
information, please see Printing
a Message.



Page Setup
Alt + F, A

View or modify the current 
specifications set for the 
headers and footers that 
appear when you print a 
message or a draft. For more 
information, please see Page 
Setup.

Printer Setup
Alt + F, N

View or modify the current 
specifications set for the printer
or printer driver. For more 
information, please see Printer 
Setup.

Exit
Alt + F, X

Exit E-Mail Connection.



The Edit Menu
When you write your email messages, E-Mail Connection puts all the editing features you would expect to
have in a text editor at your command. If you are not familiar with the commands, refer to the table below.

Select: To:

Undo
Alt + E, U
Shift + 
BkSpCtrl + Z

Reverse the results of your 
most recent action or 
command. This is particularly 
helpful after a disastrous 
editing error.

Cut
Alt + E, T
Shift + 
DelCtrl + X

Remove the currently selected 
text from your message and 
place it temporarily on the 
Clipboard.

Copy
Alt + E, C
Ctrl + InsCtrl 
+ C

Copy the currently selected text
to the Clipboard.

Paste
Alt + E, P
Shift + InsCtrl
+ V

Place the most recent contents 
of the Clipboard into your text 
at the current cursor position.

Paste From
Alt + E, F

Import a pre-existing text file 
into the current Draft Window. 
For more information, please 
see the Paste From Text File 
Dialog.

Delete
Alt + E, D
DelCtrl + X

Delete the character 
immediately to the right of the 
cursor, or delete all of the 
currently selected text from 
your message. In contrast to 
Cut, the selected text is not 
stored on the Clipboard.

Select All
Alt + E, A

Select any and all text in the 
body of your message.



Spell Check
Alt + E, S
Ctrl + S

Check the message in the 
active Draft Window for spelling
errors.



The Message Menu
E-Mail Connection exploits the most advanced email technology to offer you a complete package of 
messaging services. The Message Menu gives you easy control over both your messages and drafts. 
Refer to the table below.

Select: To:

New 
(Compose)
Alt + M, N
F2

Write a new message. E-Mail 
Connection opens a new Draft 
Window from which to write, 
address, and send your e-mail 
messages. For more 
information, please see 
Composing a Message.

Open
Alt + M, O

Open the currently selected 
message or draft. If you select 
a draft, E-Mail Connection 
opens a Draft Window. If you 
select a message, E-Mail 
Connection opens a Message 
Window.

Copy
Alt + M, C

Copy the currently selected 
message or draft into the folder
you specify. For more 
information, please see the 
Copy Message Dialog.

Move
Alt + M, M

Move the selected message or 
draft from its current location to 
a different folder. For more 
information, please see Moving
a Message.

Delete
Alt + M, D

Delete the currently selected 
message(s) and/or draft(s) from
your database, or move it to the
Trash Folder, where you can 
retrieve it later. For more 
information, please see 
Deleting a Draft or a Message.

Forward
Alt + M, F

Forward the currently selected 
message to one or more 
recipients. Forwarding mail 
works much the same as 
composing a new message. 
For more information, please 
see Forwarding a Message.



Reply
Alt + M, R

Reply to the currently selected 
message. When you reply to a 
message, E-Mail Connection 
opens a new Draft Window, 
addresses it to the sender of 
the original message, and 
copies the contents of the 
message into the Draft Window
so that you can review the 
original message as you write 
your reply. For more 
information, please see 
Replying to a Message.

Header
Alt + M, H

View the full message header. 
Generally, E-Mail Connection 
only displays the header's 
Date, Status, From, and 
Subject fields. Some messages
have detailed headers a page 
or more in length, particularly 
those sent via the Internet.

Attachments
Alt + M, A

Add, delete, or extract a file 
attachment using the Message 
Attachments dialog. E-Mail 
Connection displays a list of 
files attached to the currently 
selected draft or message. For 
more information on how to 
attach a file to a message, 
please see Attaching a File to a
Message.

View Using
Alt + M, V

Choose to view the current 
message or draft using the 
Fixed Pitch Font you chose in 
the Preferences dialog, or the 
Proportional Font. For more 
information about setting your 
document fonts, please see 
Preference's Fonts Tab.



The Folder Menu
Easy Mode and Power Mode have different Folder Menus. Which mode are you working in?

Easy Mode

Power Mode



Easy Mode Folder Menu
Use the Folder Menu to organize your messages and drafts in any way that makes sense to you--simply 
create a folder or a hierarchy of folders and label each one by topic, by sender, or by whatever criterion 
you wish. Once you have established your system of folders, you maintain it through the Folder Menu as 
well;    i.e., periodically delete folders or restructure your folders' directory/subdirectory system.

Select: To:

Open Folder
Alt + O, O

Display a list of system folders 
(Draft, Sent Mail, Inbox, 
Outbox, Trash, User). To open 
any folder, select it from the list.

Create User 
Folder
Alt + O, C

Create a new custom folder. 
The User Folder serves as the 
parent folder for all the folders 
you create in E-Mail 
Connection. The folders you 
create are hierarchical. That is, 
parent folders contain child 
folders and so on;    down as 
many layers as you care to 
create. In the Create User 
Folder dialog, select one of 
your custom folders or the User
Folder to serve as a parent 
folder. For more information, 
please see Creating a User 
Folder.

Rename 
User Folder
Alt + O, E

Change the name of any 
custom folder. You cannot 
change the name of a system 
folder. For more information, 
please see Renaming a User 
Folder.

Delete User 
Folder
Alt + O, D

Delete the currently selected 
folder along with any an all of 
its contents. For more 
information, please see 
Deleting a User Folder.

Mail Search
Alt + O, S

Search one or more folders for 
a message or a set of 
messages in your database at 
the time of your search. E-Mail 
Connection conducts the 
search based upon the 
parameters you select in a 
search template. For more 
information, please see 
Searching for a Message.



Inbox Rules
Alt + O, N

To enable this menu item, 
please see Preference's 
Display Tab. Sort your Inbox 
mail into one or more folders 
that you specify. E-Mail 
Connection conducts the rule-
based sort based upon 
parameters you select in a 
simple template. For more 
information, please see Sorting 
New Mail.



Power Mode Folder Menu
Use the Folder Menu to organize your messages and drafts in any way that makes sense to you--simply 
create a folder or a hierarchy of folders and label each one by topic, by sender, or by whatever criterion 
you wish. Once you have established your system of folders, you maintain it through the Folder Menu as 
well;    i.e., periodically delete folders or restructure your folders' directory/subdirectory system.

Select: To:

New Folder 
Window
Alt + O, W

Open a new Folder Window on 
your desktop. By default, E-
Mail Connection opens a User 
Folder Window.

Open Folder
Alt + O, O

Display a list of system folders 
(Draft, Sent Mail, Inbox, 
Outbox, Trash, User). To open 
any folder, select it from the list.

Create User 
Folder
Alt + O, C

Create a new custom folder. 
The User Folder serves as the 
parent folder for all the folders 
you create in E-Mail 
Connection. The folders you 
create are hierarchical. That is, 
parent folders contain child 
folders and so on;    down as 
many layers as you care to 
create. In the Create User 
Folder dialog, select one of 
your custom folders or the User
Folder to serve as a parent 
folder. For more information, 
please see Creating a User 
Folder.

Rename 
User Folder
Alt + O, E

Change the name of any 
custom folder. You cannot 
change the name of a system 
folder. For more information, 
please see Renaming a User 
Folder.

Delete User 
Folder
Alt + O, D

Delete the currently selected 
folder along with any an all of 
its contents. For more 
information, please see 
Deleting a User Folder.

Mail Search
Alt + O, S

Search one or more folders for 
a message or a set of 
messages in your database at 
the time of your search. E-Mail 



Connection conducts the 
search based upon the 
parameters you select in a 
search template. For more 
information, please see 
Searching for a Message.

Inbox Rules
Alt + O, R

To enable this menu item, 
please see Preference's 
Display Tab. Sort your Inbox 
mail into one or more folders 
that you specify. E-Mail 
Connection conducts the rule-
based sort based upon 
parameters you select in a 
simple template. For more 
information, please see Sorting 
New Mail.



The Window Menu
The Window Menu is only available in Power Mode. It allows you to control the appearance of your 
desktop. E-Mail Connection utilizes MDI (multiple document interface) technology, which means it has the
capacity to maintain several open windows in view.

For example, you could have several Message windows open, each with a different message from a 
different source, but all concerning the same project. While those windows were open, you could be 
working in a Draft window composing your response and referring to the messages when you found it 
necessary.

Select: To:

Cascade
Alt + W, C

Arrange the windows on your 
desktop so that the newest 
window overlaps its 
predecessor, yet the boundary 
and the title bar of the 
overlapped window are still 
visible.

Tile 
Horizontally
Alt + W, T

Resize and rearrange the 
windows on your desktop side 
by side so that as much of each
window is visible as is possible.

Tile Vertically
Alt + W, V

Resize and rearrange the 
windows on your desktop top to
bottom so that as much of each
window is visible as is possible.

Arrange 
Icons
Alt + W, A

Line your minimized windows in
a row along the bottom of your 
desktop.

Close All
Alt + W, L

Close any and all windows 
currently open on your desktop.

Note    At the bottom of the list box is a list of open windows in E-Mail Connection, each with a number in front of it. You 
can shift the focus to a window by selecting it from the list, or by pressing Alt + W, followed by the number in front of the 
window. The currently active window has a check mark in front of it.

If you have the Window Bar enabled, each open window has a corresponding icon on the right side of your desktop. To 
view the window, double-click its representative icon. For more information about the Window Bar, please see The Window
Bar.



The Main Window Tool Bar
Easy Mode and Power Mode have different Main Window Tool Bars. Which mode are you working in?

Easy Mode

Power Mode



The Easy Mode Main Tool Bar
All of the windows in E-Mail Connection share a common tool bar that gives you immediate access to 
commands from anywhere on your desktop. Each button on the Main Tool Bar is labeled explicitly by 
command.

Clicking the Help button opens 
the Help file you are currently 
reading.

Clicking the Compose button 
pens a Draft Window, where 
you write all your email 
messages. For more 
information, please see 
Composing a Message.

Clicking the Address button 
opens your Address Book, 
where you add or modify 
recipient information.

Clicking the Inbox button opens
your Inbox Folder, where you 
read your new messages.

Clicking the Folders button 
opens the Folder window, 
where you store, organize, and 
read messages you have 
received.

Clicking the Print button prints 
a copy of the selected 
message(s) and /or draft(s). 
For more information, please 
see Printing a Message.

Clicking the Search button 
searches one or more Folders 
for a message or a set of 
messages in your database at 
the time of your search. E-Mail 
Connection conducts the 



search based upon the 
parameters you select in a 
Search template. For more 
information, see Searching for 
a Message.

Clicking the Connect button 
connects you to the mail server
of your choice so that you can 
exchange email.

The Power Mode Main Tool Bar
All of the windows in E-Mail Connection share a common tool bar that gives you immediate access to 
commands from anywhere on your desktop. Each button on the Main Tool Bar is labeled explicitly by 
command.

Clicking the Help button opens 
the Help file you are currently 
reading.

Clicking the Compose button 
opens a Draft Window, where 
you write all your email 
messages. For more 
information, please see 
Composing a Message.

Clicking the Forward button 
forwards the selected message
to one or more recipients. 
Forwarding mail works much 
the same as composing a new 
message. For more 
information, please see 
Forwarding a Message.

Clicking the Reply button 
replies to the selected 
message. By default, E-Mail 
Connection addresses your 
reply to the sender and copies 
the original message into the 
Draft window edit field so that 
you can review the original 
message as you compose your
reply. For more information, 
please see Replying to a 
Message.



Clicking the Print button prints 
a copy of the selected 
message(s) and /or draft(s). 
For more information, please 
see Printing a Message.

Clicking the Delete button 
deletes the selected 
message(s) and/or draft(s). You
have the option of placing the 
message in the Trash Folder, 
where you can retrieve it later if
you need to, or deleting the 
message from your database 
altogether.

Clicking the Search button 
searches one or more Folders 
for a message or a set of 
messages in your database at 
the time of your search. E-Mail 
Connection conducts the 
search over a broad range of 
parameters including, but not 
limited to, sender, subject, date,
and text. For more information, 
please see Searching for a 
Message.

Clicking the Connect button 
connects you to the mail server
of your choice so that you can 
exchange email.



The Draft Window Tool Bar
Easy Mode and Power Mode have different Draft Window Tool Bars. Which mode are you working in?

Easy Mode

Power Mode



The Easy Mode Draft Tool Bar
For your convenience, E-Mail Connection includes the most common Draft Window commands on the 
Draft Window Tool Bar. Each button on the Draft Window Tool Bar is labeled explicitly by command.

Clicking the Send button 
sends or queues to send 
the message in the current
Draft window to the 
recipient(s) in the To or CC
list boxes. Messages 
"queued to be sent" wait in
your Outbox until the Mail 
Scheduler picks them up 
and transmits them over 
the selected mail system.

Clicking the Handling 
button allows you to select 
from among message 
handling options such as 
Return Receipt, Priority 
Mail, and document Mode. 
For more information, 
please see the Handling 
Dialog.

Clicking the Address 
button addresses the email
message in the current 
Draft window. E-Mail 
Connection opens the 
Address Message dialog, 
where you can select your 
recipients from a master 
list.

Clicking the Attach button 
attaches a file to the 
current draft. In many 
cases, it is easier to attach 
a file to an email message 
than to upload and transfer
the file directly. For more 
information, please see 
Attaching a File to a 
Message.

Clicking the Spell button 
checks the draft for 
spelling errors.



Clicking the Save button 
saves the contents of the 
current Draft Window to 
the Draft Folder. E-Mail 
Connection uses your 
subject summary as the 
name of the saved draft. 
The Save command is 
useful when you work on a
draft over a number of E-
Mail Connection sessions. 
It should not be confused 
with the Keep Copy option 
(in the Preferences dialog),
which saves a copy of 
each message you send to
the Sent Mail folder.

Clicking the Close button 
closes all of your Folders 
and returns you to the 
main E-Mail Connection 
desktop.



The Power Mode Draft Tool Bar
For your convenience, E-Mail Connection includes the most common Draft Window commands on the 
Draft Window Tool Bar. Each button on the Draft Window Tool Bar is labeled explicitly by command.

Clicking the Send button 
sends or queues to send 
the message in the current
Draft Window to the 
recipient(s) in the To or CC
list boxes. By default, E-
Mail Connection transmits 
a LAN message 
immediately over your 
network;    all other 
messages are "queued to 
be sent." Messages 
"queued to be sent" wait in
your Outbox until the Mail 
Scheduler picks them up 
and delivers them.

Clicking the Handling 
button allows you to select 
from among message 
handling options such as 
Return Receipt, Priority 
Mail, and Document Mode.
For more information, 
please see the Handling 
Dialog.

Clicking the Address 
button addresses the email
message in the current 
Draft Window. E-Mail 
Connection opens the 
Address Draft dialog, 
where you can select your 
recipients from a master 
list.

Clicking the Routing button
allows you to view your 
recipient's default 
destination address and 
the route your message 
will take from your 
machine to its ultimate 
end. To change the 
destination address you 
want to use, click the arrow
on the Destination drop 
down list box and select 
the address from the list 



that appears. If your 
recipient has only one 
destination address in your
Address Book, the 
Destination drop down list 
box will be disabled.

Clicking the Attach button 
attaches a file to the 
current draft. In many 
cases, it is easier to attach 
a file to an e-mail message
than to upload and transfer
the file directly. The 
number of files you can 
attach is dependent upon 
the size of your files.    You 
must attach one file at a 
time. A file attachment 
appears as an application 
icon in the right-hand 
column of the Draft 
Window edit field. To 
extend the edit field back 
to its normal size, position 
the mouse over the vertical
bar that separates the edit 
field from the file 
attachment field and drag 
the split bar to the right. 
Before you attach a file to 
a message, be sure your 
recipient can extract and 
launch the file. That is, be 
sure your recipient has an 
application that can open 
and read the file. For more 
information, please see 
Attaching a File to a 
Message.
Clicking the Spell button 
checks the draft for 
spelling errors.

Clicking the Save button 
saves the contents of the 
current Draft Window to 
the Draft Folder. E-Mail 
Connection uses your 
subject summary as the 
name of the saved draft. 
The Save command is 
useful when you work on a
draft over a number of E-
Mail Connection sessions. 
It should not be confused 
with the Keep Copy option 
(in the Preferences dialog),



which saves a copy of 
each message you send to
the Sent Mail folder.



The Message Window Tool Bar
Easy Mode and Power Mode have different Message Window Tool Bars. Which mode are you working 
in?

Easy Mode

Power Mode



The Easy Mode Message Tool Bar
For your convenience, E-Mail Connection includes the most common Message Window commands on 
the Message Window Tool Bar. Each button on the Message Window Tool Bar is labeled explicitly by 
command.

Clicking the Sender button 
allows you to view the 
sender's name and email 
address, as well as routing
information about the 
message. If you do not 
have the Auto Add to 
Address Book option 
selected in the 
Preferences dialog, click 
the Add Address Entry 
button to add the sender's 
address to your Address 
Book. Click View Address 
Entry to open the sender's 
Address Entry dialog.

Clicking the Recipients 
button allows you to view a
list of recipients who 
received the active 
message E-Mail 
Connection displays 
address and routing details
for the selected recipient, 
and gives you the option to
open his or her Address 
Entry dialog. If you do not 
have the Auto Add to 
Address Book option 
selected in the 
Preferences dialog, click 
the Add Address Entry 
button to add the selected 
recipient's address to your 
Address Book.

Clicking the Move button 
moves the active message
to a different folder. For 
more information, please 
see Moving a Message.

Clicking the Forward 
button forwards the active 
message to one or more 
recipients. For more 
information, please see 
Forwarding a Message.



Clicking the Reply button 
allows you to reply to the 
active message. For more 
information, please see 
Replying to a Message.

Clicking the Delete button 
deletes the active 
message. For more 
information, please see 
Deleting a Draft or a 
Message.

Clicking the Close button 
closes the active message.



The Power Mode Message Tool Bar
For your convenience, E-Mail Connection includes the most common Message Window commands on 
the Message Window Tool Bar. Each button on the Message Window Tool Bar is labeled explicitly by 
command.

Clicking the Header button 
allows you to view the full 
message header. In the 
message window, E-Mail 
Connection only displays 
the header's Date, Status, 
From, and Subject fields. 
Some messages have 
detailed headers a page or
more in length, particularly 
those send via the Internet.

Clicking the Sender button 
allows you to view the 
sender's name and email 
address, as well as routing
information about the 
message. If you do not 
have the Auto Add to 
Address Book option 
selected in the 
Preferences dialog, click 
the Add Address Entry to 
open the sender's Address
Entry dialog.

Clicking the Recipients 
button allows you to view a
list of recipients who 
received the active 
message. E-Mail 
Connection displays 
address and routing details
for the selected recipient, 
and gives you the option to
open his or her Address 
Entry dialog. If you do not 
have the Auto Add to 
Address Book option 
selected in the 
Preferences dialog, click 
the Add Address Entry 
button to add the selected 
recipient's address to your 
Address Book.
Clicking the Attachments 
button extracts an 
attachment from the 
currently active message 
to a file on your hard disk, 



or removes the attachment
from the message. For 
more information, please 
see the Extract File Dialog.

Clicking the Print button 
prints the message in the 
currently active Message 
Window.



The Folder Window Tool Bar
For your convenience, E-Mail Connection includes the most common Folder Window commands on the 
Folder Window Tool Bar (only in Easy Mode). Each button is labeled explicitly by command.

Clicking the Read button 
allows you to open a 
Message Window to read 
the selected message.

Clicking the Move button 
moves the selected 
message or draft from its 
current location to a 
different folder. For more 
information, please see 
Moving a Message.

Clicking the Forward 
button forwards the 
currently selected 
message to one or more 
recipients. Forwarding mail
works much the same as 
composing a new 
message. For more 
information, please see 
Forwarding a Message.

Clicking the Reply button 
allows you to reply to the 
currently selected 
message. When you reply 
to a message, E-Mail 
Connection opens a new 
Draft window, addresses it 
to the sender of the 
original message, and 
copies the contents of the 
message into the Draft 
window so that you can 
review the original 
message as you compose 
your reply. For more 
information, please see 
Replying to a Message.

Clicking the Print button 
prints a copy of the 
selected message(s) 
and/or draft(s). Before you 
print the first message in 
an E-Mail Connection 
session, it is a good idea to



select Printer Setup from 
the File menu first and 
check the current printer 
specifications. To check 
the current header and 
footer settings, select Page
Setup in the File menu. For
more information, please 
see Printing a Message.

Clicking the Delete button 
deletes the active 
message.

Clicking the Close button 
closes the Folder Window 
and returns you to the 
main E-Mail Connection 
desktop.



Technical Support
Our customer support staff, is available at the following e-mail address:

· SUPPORT@CONNECTSOFT.COM

We also provide support on our World Wide Web home page:

· HTTP://WWW.CONNECTSOFT.COM

The technical support staff can help you most effectively if you include the following information in your e-
mail message:

1. The version of E-Mail Connection you are running. (To find out, select About E-Mail Connection 
in the Help menu.)

2. The type of hardware you are using, particularly your modem and network (if any).

3. The exact wording of the message that appeared on your screen, prompting you to contact our 
technical support staff.

4. A clear description of what happened and exactly what you were doing when you encountered 
the problem.

5. A summary of your attempts to remedy the problem.

If you experience difficulty connecting to your Internet provider from within E-Mail Connection, try 
connecting directly. If you still experience difficulty, please contact your services technical support staff:
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Advanced Installation and Configuration Dialogs and Features
Advanced Settings in the Internet Mail Setup Dialog

Before You Connect

Change Password Dialog

Handling Dialog

Mail System Schedule (Modem Services)

Mail System Schedule (Network Services)
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Advanced Settings in the Internet Mail Setup Dialog
When you click the More button in the Internet Mail Setup dialog box, E-Mail Connection displays the 
options discussed below.

By default, E-Mail Connection sets the POP3 port (Post Office Protocol port) to 110, and the SMTP port 
(Simple Mail Transfer Protocol port) to 25. You should leave these values set to their defaults unless your 
Internet provider tells you explicitly to change them.

Delete mail from server. In order to preserve resources on your Internet Server, E-Mail Connection can 
delete any and all your messages from your Internet server once it is safely in your E-Mail Connection 
Inbox.

TCP timeout. When you attempt to connect to your Internet host from your LAN, it is your TCP 
(Transmission Control Protocol) stack that establishes the connection. Moreover, the stack expects to 
establish the connection within a predetermined interval of time.

In most cases, you will not need to change the default setting, but if the host is too slow to respond, the 
stack will timeout and fail to establish a connection. On the other hand, if the host is down and the TCP 
timeout is set for a long interval, the stack will keep trying to establish a connection even though it is 
impossible.

Once you find a reasonable interval that gives your host enough time to respond to the stack, you will 
probably not have to change the field again.

Show Send/Receive. If selected, E-Mail Connection displays a dialog when you send or receive 
messages. The dialog lets you monitor the progress of uploads to and downloads from, your Internet 
host(s).

MIME. Send binary file attachments to your recipients using MIME.

UUENCODE. Send binary file attachments to your recipients using UUENCODE.



Before you Connect
By default, E-Mail Connection displays this dialog before it attempts to log on to a modem-based server.    
The dialog lets you control the flow of incoming and/or outgoing mail.    In particular, you instruct E-Mail 
Connection to pick up incoming mail only, transmit outbound mail only, or do both.

Select Receive Incoming Messages to download your messages from the modem-based server.    The 
ability to turn the option off is very important when you know beforehand that you have a large file to 
download, and all you have time to do is send a quick message.

Select Send Outgoing Messages to transmit the messages in your Outbox that are bound for the 
selected service.    The ability to turn this option off is very important when you have one or more large 
files (that may take time to upload) attached to messages in your Outbox, and all you have time to do is 
download an urgent message.

Once you have set the options above and clicked OK, E-Mail Connection will attempt to log on to the 
modem-based server.

If you change your mind and do not want to log on at this time, click Cancel.



Change Password Dialog
The Change Password dialog appears when you click the Change Password button in the User 
Information Dialog.

1. Type your old Password in the Current Password box. For your protection and security, the 
password you enter will not echo to the screen. Instead, when you type a character, you will see 
an asterisk.

2. Use the New Password box to change your Password.

3. To ensure you have entered your new Password correctly, type it again in the Password Match 
text box.

4. Click OK to accept the change.

Related Topic:
How many characters may my password have?



Handling Dialog
The Handling dialog appears when you click the Handling button in a Draft Window. The options are 
message wide and override any per recipient options you set in the Recipient Routing Options dialog. For 
example, if you send a message to 10 different recipients and mark the message Priority in the Handling 
dialog, each of your recipients will receive a priority message, no matter what options may or may not be 
set for each individual recipient in their respective Recipient Routing Options dialogs. (By the way, you 
access the Recipient Routing Options dialog by double-clicking a recipients name in the Draft window To 
box.)

Message Options:

· Priority Message. If selected, your message is labeled PRIORITY and placed at the top of your 
recipient's Inbox.

· Return Receipt. If selected, you will receive e-mail verification that your recipient has received 
your e-mail message.

· Keep Copy. Save a copy of the message in the Sent Mail Folder.

Related Topics:
Recipient Routing Options dialog



Mail System Schedule (Modem Services)
For more information about scheduling network mail, please see the Mail System Schedule (Network Services).

The modem Mail System Schedule appears when you click the Schedule button if the SLIP/PPP option is 
selected in the Internet Mail Setup dialog box.

1. Begin Connecting at. Type the time you want E-Mail Connection to conduct the first login of the 
day. The default is 9:00am.

You may use military time (0:00--23:59) or civilian time (12:00am--11:59am, 12:00pm--11:59pm). 
Do not forget to append 'am' or 'pm' to a time you enter in the twelve hour format.

2. Provided E-Mail Connection is running and your modem is turned on, E-Mail Connection will 
automatically log you on to the host computer at the specified time.

If you have outbound mail, it is transmitted first. Next, E-Mail Connection picks up your mail (if 
any), then logs off.

3. Connect Every:    __ minutes. The interval between login times, in minutes. Try to estimate a 
reasonable interval between login times. If you do not know, start with 60 minute intervals, then 
expand or contract the interval as you see a clear pattern emerge.

4. End Connecting at. E-Mail Connection will not attempt to log on to the host computer past the 
time you specify. The default is 5:00pm. Again, either military or civilian time formats are 
acceptable.

5. Days to Connect. Select the days you want E-Mail Connection to abide by the "connect 
schedule" you have created. The default connection days are Monday through Friday.

Note:
You can continue to work in your other windows applications while E-Mail Connection uploads or downloads messages, 
application files, etc. Just press Alt + Tab to switch to any other open application.

If you are using a SLIP or PPP stack to connect to a remote Internet host, make sure your stack is configured to dial out 
automatically when it is called by other applications such as E-Mail Connection. If you are not sure, contact your stack 
provider.

The Connect button on the main window tool bar bypasses the automatic schedule and allows you to 
connect to your modem-based e-mail system instantly.

Related Topic:
Overriding the Mail System Schedule



Mail System Schedule (Network Services)
For more information about scheduling modem-based mail, please see the Mail System Schedule (Modem Services).

The network Mail System Schedule appears when you click the Schedule button and the LAN option is 
selected in the Internet Mail Setup dialog box.

Mail Scanning Frequency. Refers to the interval of time that passes before E-Mail Connection checks 
your network mailbox for new mail. Your network mailbox is distinct from your E-Mail Connection Inbox 
and Outbox. In order for E-Mail Connection to retrieve your network mail and place it in your Inbox, it must
scan the network for mail addressed to you.

If you do not know how often you are likely to receive mail, choose a 10 to 20 minute interval to start, then
expand or contract it as you gain a better feel for the flow of mail to you over the network.

Transmit Outgoing Mail. Instructs E-Mail Connection when to transmit mail that is in your Outbox over 
the network.

· When Sent. Transmit outgoing mail immediately after you click Send in a Draft Window.

· At Scan Intervals. Outgoing mail waits in your Outbox until E-Mail Connection performs the next 
scan of the network for new mail.

Of course you may override any of the automated settings in the Mail Schedule and scan the network at 
any time for new mail by clicking the Connect button on the main window tool bar.

Using the Connect button does not reset or disrupt the default scan interval. For example, suppose you 
have the Mail Scanning Frequency set for 12 minutes, and you click Connect after only 4 minutes have 
passed since the last network scan. In 8 more minutes, E-Mail Connection will automatically scan the 
network again.

Related Topic:
Overriding the Mail System Schedule



Mailbox Update Utility
The Mailbox Update Utility is a database utility that cleans up and reorganizes your e-mail applications 
database files. After you run it, you will notice a dramatic reduction in the time it takes your application to 
load and access data files. Moreover, the data files themselves will occupy less space on your hard drive. 

If you have received an Internal Database Alert from your e-mail application, follow the instructions below.

Updating your database Step-by-Step

Starting Up

1. First, close E-Mail Connection.

2. Open Program Manager, click File from the menu bar and click Run. Click the Browse button 
and locate the main directory of your e-mail application. Look for a file named DBUTIL.EXE. 
Select the file, then click OK in both the Browse and Run dialogs.

Select a User then click the Start button

1. Each E-Mail Connection user has his own database. The Mailbox Update Utility locates the E-
Mail Connection database files on startup, and lists the users in the User list box. Select a user, 
then click the Start button.

2. As the Mailbox Update Utility runs, it tells you what it is doing every step of the way with text and 
graphic displays. Depending upon the number of folders and messages you have, along with the 
speed of your computer, the process can take time to complete. 

Where is my old database?

When the Mailbox Update Utility is finished, it zips up your old database and places it in your E-Mail 
Connection database directory.

How do I open my old database?

Use PKUNZIP.EXE, a decompression utility widely available on BBSs and the Internet.



Message Headers Dialog
The Message Headers dialog appears when you click the Header button in any destination address 
dialog. When you send a message, E-Mail Connection can include an optional header to your messages. 
The header details the names and addresses of all those who received your message, as well as what file
attachments, if any, you sent.

The header is especially useful when you send e-mail to multiple recipients.

Your options are as follows:

· Use default. By default, E-Mail Connection includes the header on all outbound messages.

· Include message header. You always want E-Mail Connection to send a header with your 
messages.

· Do not include message header. You never want E-Mail Connection to send a header with any 
messages you send.

Click OK to make your changes;    clicking Cancel exits the dialog without affecting any change.



Internet Mail Setup
1. Mail host name. Type in the full name of the Internet host over which you receive your mail. Use 

the example as a guide. If you are using a TCP/IP (Transmission Control Protocol/Internet 
Protocol) stack and you are not sure what the full name is, talk to your network administrator. If 
you are using a SLIP (Serial Link Internet Protocol) connection, contact your Internet provider.

2. SMTP relay name (Simple Mail Transfer Protocol relay name). In most cases, the Internet host 
you use to receive your mail is the same as the one you use to send your mail. If you use two 
distinct hosts, use the SMTP relay name box to enter the full name of the host over which you 
send your mail.

3. User ID. Type in the name you use to login to your Internet account. The ID is usually a first initial
followed by a last name, or some variation on your name.

4. Password. Type the Password that gives you access to your Internet account.

5. Return Address. Type in your Internet address. The first box is for your User ID;    the second is 
for the domain. For example dyeend@internet.com

6. TCP Connection Type (Transmission Control Protocol Connection Type). Choose SLIP/PPP 
(Serial Link Internet Protocol/Point to Point Protocol) if you need a modem to contact your 
Internet provider.
Otherwise, choose LAN (Local Area Network)

To view or to set more advanced options, click the More button. 

For information about scheduling mail for a TCP connection (i.e., your LAN is connected to your Internet 
server), please see the Mail System Schedule (Modem Services).

For more information about scheduling mail for a SLIP connection (i.e., you need a modem to connect to 
your Internet server), please see the Mail System Schedule (Network Services).

Related Topics:
Advanced Settings

View Log



Select Wallpaper Bitmap Dialog
The Select Wallpaper Bitmap dialog appears when you click the Set Wallpaper button in Preferences's 
Wallpaper Tab. The dialog lets you browse your hard disk for the .BMP file you want displayed on your E-
Mail Connection desktop.

Select the file you want displayed on your desktop and click OK. Clicking Cancel exits the dialog without 
affecting any change.



The Split Bar
E-Mail Connection has a multitude of features designed to put you in control of your desktop. One simple 
yet invaluable feature is your ability to resize the columns and fields in virtually every E-Mail Connection 
window.

To adjust the width of any column, position the mouse anywhere along the split bars, then drag the mouse
right or left.

For example, in the Folder windows, point the mouse at the split bar between the From and Subject 
headings:

The cursor changes shape to a double-headed arrow:

Now drag the mouse left or right until the column is the width you want. To adjust all the columns right or 
left, press the Shift key as you drag the mouse.

Note as well that the long horizontal and vertical lines that divide the Folder window into different fields 
are split bars as well. On these split bars however, the cursor will change to look like either of:

or 

The first cursor shape indicates that you can adjust the vertical position of the split bar by dragging the 
mouse up or down. The second shape indicates you can adjust the horizontal position of the split bar by 
dragging the mouse right or left.



Transport Log Dialog
E-Mail Connection generates and maintains a log file that tracks, among other things, connect times, 
messages received, who sent each message, when they sent it, and when you received it.

Log files provide accurate information for accounting purposes, and include any error messages. These 
messages can be especially useful as an aid to solving problems you may experience.

If you have problems connecting to any host computer using E-Mail Connection, it is a good idea to click 
the appropriate View Log button in the Mail Systems window and take a look at any messages that may 
have been generated during your failed session(s).

The messages will often point to a simple problem that is easy to correct, or give you informative insights 
into why your session failed to produce the desired results. 

If your LAN generates a message you do not understand, consult your network administrator.

If your Internet host generates a message you do not understand, contact your Internet provider.
Note:
E-Mail Connection only retains 16K of text in the Transport Log when you exit. Any remaining text is 
automatically deleted.

Related Topics:
Technical Support



User Information Dialog
The User Information dialog appears when you select User Info in the File menu. E-Mail Connection uses
the dialog to store all your personal information.

· Click Set Password to create, or Change Password to modify or delete your E-Mail Connection 
Password. For more information, please see the Set Password dialog or the Change Password 
dialog.

· Double-click any of the Address Types to add a new destination address for yourself in your 
Address Book. For example, to enter your MCI Mail address, double-click MCI Mail. For more 
information about how to complete the various destination address dialogs, please see The 
Directory of Destination Addresses.

· Double-click any of the Destination Addresses to modify address information you have 
previously entered. For example, if you entered your Internet address incorrectly, double-click 
Internet and edit the information in the Internet Address dialog.

· Click Remove to remove the selected address in the Destination Addresses list box from your 
Address Book.

· Click the Default Destination box at the bottom of the dialog to set your own default address. 
When the pick list of all your addresses appears, click the address of your choice.



User Login Dialog
If you have configured E-Mail Connection for multiple users, the User Login dialog appears on startup. 
Select your name from the Name box and type your password in the Password field. For your protection 
and security, your password will not appear on the screen. Instead, when you type a character, the field 
will display an asterisk.

Click OK when you are sure all the information is correct. If you enter your password incorrectly (or just 
forget to enter it), you will be asked to enter it again. E-Mail Connection will not open until the information 
in the User Login dialog is accurate and complete.

Click Cancel if you change your mind and do not wish to open E-Mail Connection.



User Registration Information Dialog
The User Registration Information dialog appears when you click Modify in the Online Registration 
dialog. It lets you edit the information you entered in the New User Information Dialog.



The Window Bar
The Window Bar is available in E-Mail Connection's Power Mode. Every time you open a window in E-
Mail Connection, an icon for that window appears in the far-right column of the desktop. In addition, the 
column has six permanent icons that give you easy access to your Inbox, Outbox, Mail Systems, Address 
Book, E-Mail Connection, and Folder Windows.

Why? Think of it this way:    during any given project, reams of paper and multiple books cross your 
desktop. And when you are done with a book, you probably have a place to put it that is within reach, yet 
out of the way.

If you think of your open windows as loose pieces of paper on your desktop, it is natural to look for a 
'shelf' where you can put them away, yet keep them within easy reach.

E-Mail Connection provides you with just such a 'shelf'. It runs the vertical length of the desktop and 
appears as a column slightly more than an inch wide when your desk top is maximized.

The area is a new feature called the Window Bar. With the Window Bar, important system windows and 
any other open windows remain visible at all times, in one place, and easy to access.

You do not have to use the Window Bar if you do not want to. To change or view the current default, 
select Preferences in the File menu. A dialog with eight vertical Tabs will appear. Click Display. Under 
Power Mode, use the Show Window Bar option to toggle between showing the Window Bar or hiding it 
from view.

If you hide the Window Bar, E-Mail Connection uses the traditional MDI interface;    i.e., any windows you 
have minimized will appear as icons at the bottom of your desktop, and you access open windows by 
pressing Ctrl + F6, or by clicking Window in the menu bar, and selecting the window you want to view.



Advanced Addressing Dialogs and Features
Deleting Addresses

Directory of Destination Addresses

Fax Address Dialog

Modifying Addresses

Postal Address Dialog

Recipient Details Dialog

Recipient List Details Dialog

Recipient Routing Options

Sender Details



Deleting Addresses
To delete an address:

1. Open your Address Book by clicking the Address button.

2. Click once on the address that you want to delete.

3. Click the Delete button.

E-Mail Connection asks you to confirm the deletion.

4. Click the Yes button to delete the selected address.



Directory of Destination Addresses
America Online Address Dialog

AppleLink Address Dialog

AT&T EasyLink Address Dialog

AT&T Mail Address Dialog

CompuServe Address Dialog

Fax Address Dialog

GEnie Address Dialog

Internet Address Dialog

MCI Mail Address (Instant) Dialog

Postal Address Dialog



America Online Address Dialog

8619 Westwood Center Dr., Ste. 200

Vienna, VA. 22182-9806

800-827-6364

703-448-8700

To Complete the America Online Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. In the User ID text box, enter your recipient's America Online subscription ID.

3. For information on the Header button, see the Message Headers Dialog.

4. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



AppleLink Address Dialog

Apple Computer, Inc.

20525 Mariani Ave.

Cupertino, CA 95014

408-996-1010

408-974-3309

To Complete the AppleLink Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. In the User ID text box, enter your recipient's AppleLink ID.

3. For information on the Header button, see the Message Headers Dialog.

4. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



AT&T EasyLink Address Dialog

AT&T EasyLink Services

5501 LBJ Freeway

Room 1015

Dallas, TX 75240

800-242-6005

214-308-4235 (FAX)

To Complete the AT&T EasyLink Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. In the AT&T EasyLink ID text box, enter your recipient's ID.

3. For information on the Header button, see the Message Headers Dialog.

4. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



AT&T Mail Address Dialog

AT&T Mail

5501 LBJ Freeway

Room 1015

Dallas, TX 75240

800-242-6005

214-308-4235 (FAX)

To Complete the AT&T Mail Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. In the AT&T Mail ID text box, enter your recipient's ID.

3. For information on the Header button, see the Message Headers Dialog.

4. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



CompuServe Address Dialog

5000 Arlington Centre Blvd.

P.O. Box 20212

Columbus, OH 43220

800-848-8199

614-457-8600

To Complete the CompuServe Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. In the User ID field, enter your recipient's CompuServe User ID. The ID is usually five or six 
numbers followed by a comma, and then three or four additional numbers. For example, 
12345,678 or 12345,6789.

3. For information on the Header button, see the Message Headers Dialog.

4. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



GEnie Address Dialog

General Electric Company, U.S.A

401 N Washington St.

PO Box 6403

Rockville, MD 20849-6403

800-638-9636

To Complete the GEnie Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. Type your recipient's GEnie User name in the User ID box. The name is usually a first initial 
followed by a last name.

3. For information on the Header button, see the Message Headers Dialog.

4. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



Internet Address Dialog

To Complete the Internet Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. In the User Name field, type in your recipient's Internet User Name. The name is usually a first 
initial followed by a last name, or part of a last name followed by the first letter of his or her first 
name. For example, Johnny Snyder might be jsnyder.

3. Internet mail is transmitted from network to network. Each network has a name, known as a 
domain;    individual sites within the network are known as subdomains. The general form of an 
Internet address is username@subdomain.domain.

Under Domain:, type in any and all subdomains as well as the domain. Separate subdomains for 
one another with a period. For example, to send mail to the math department at the University of 
New Mexico, you would enter math.unm.edu. Domain names are abbreviations for the function 
of the site associated with the network. For instance 'edu' is an educational institution, 'com' is a 
commercial site, 'gov' is a government site, etc.

4. For information on the Header button, see the Message Headers Dialog.

5. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



MCI Mail Address (Instant) Dialog

1111 19th St. NW, Ste. 500

Washington, DC 20036

800-444-MAIL

800-677-3303 (FAX)

To Complete the MCI (Instant) Mail Address Dialog:

1. E-Mail Connection automatically fills in the User Name field for you.

2. Type the seven-digit number that MCI assigned to your recipient in the MCI ID text box. The 
number resembles a standard telephone number.

3. Type your recipient's MCI Mail User name in the MCI Name text box. The name is usually a first 
initial followed by a last name.

4. For information on the Header button, see the Message Headers Dialog.

5. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



FAX Address Dialog

To Complete the FAX Address Dialog:

1. E-Mail Connection automatically fills in the Name field for you.

2. If you filled in the Company field when you added your recipient to your Address Book, E-Mail 
Connection automatically fills in the Company Name field for you. Otherwise, type your recipient's
company name as you would like it to appear on the Fax cover page. To skip the option, leave the
field blank.

3. In the FAX Phone field, click US & Canada if your recipient's fax machine is in one of those two 
countries. Select International otherwise.

4. If you select US & Canada, E-Mail Connection colors in the map of North America. To the left of 
the map are three text boxes and two options. Type the complete fax number in the three fields;    
for example 203 555 1212. Do not include dashes.

Check the Local Dial field near the middle of the dialog. This number should match the number 
you would dial to reach your recipient's FAX machine directly. Click Long Distance to append a 1
to the number;    click Local call requires area code to append the area code to the number.

5. If you select International, E-Mail Connection displays a world map, and the fields change. Fill in 
the fields, using standard telephone codes for the destination country and city;    type in the 
telephone number as you would dial it from a telephone.

6. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



Modifying Addresses
To modify an address:

1. Open your Address Book by clicking the Address button.

2. Click once on the address that you want to modify.

3. Click the Modify button.

4. Make changes to the address in the Address Book Entry dialog.

5. Click the OK button.



Postal Address Dialog
To Complete the Postal Address Dialog

1. At the top of the dialog, select Residence or Office, depending upon where your recipient will 
receive your message. Select Office to enable the Company field (step 3 below). Select 
Residence to disable it.

2. E-Mail Connection automatically fills in the Name field for you.

3. If you filled in the Company field when you added your recipient to your Address Book, E-Mail 
Connection automatically fills in the Company Name field for you. Otherwise, type the appropriate
company name. To skip the option, leave the field blank.

4. Enter the primary address in the Street Address 1 field. Enter a secondary address in the Street 
Address 2 field. The second address field is optional.

5. At the bottom of the dialog, select one of the options listed under Country. The default setting is 
the United States. If you select Canada, the map shifts to a red Canadian map;    the flag to a 
Canadian flag. If you select Other, a new text box opens beneath a world map. Type the name of 
the country in the new text box.

6. Now type the city in the City field, the state or province in the State/Province field, and the Zip 
Code or International Postal Code in the Zip/Postal Code field.

7. Click OK to save the information and exit the dialog. Clicking Cancel will exit the dialog without 
saving changes.



Recipient Details Dialog
The Recipient Details dialog appears when you double-click a recipient's name in the To or CC box of a 
message window. The dialog lets you view the recipient's name and e-mail address, along with routing 
information about the message.

If you do not have the Auto Add to Address Book option selected in the Preferences Dialog (New Mail 
Tab), click the Add Address Entry button to add the recipient's address to your Address Book.

Click View Address Entry to open the recipient's Address Book Entry dialog;    i.e., their entry in your 
Address Book.



Recipient List Details Dialog
The Recipient List Details dialog appears when you click the Recipients button in a Message window. 
The dialog lets you view a list of recipients who received the selected message. E-Mail Connection 
displays address and routing details for the selected recipient, and gives you the option to open his or her 
Address Book Entry dialog.
If you do not have the Auto Add to Address Book option selected in the Preferences dialog, click the 
Add Address Entry button to add the selected recipient's address to your Address Book.



Recipient Routing Options Dialog
The Recipient Routing Option dialog appears when you double-click a recipients name in the Draft 
window To box. The options in this dialog are set on a per recipient basis and may be overridden by the 
message wide options you set in the Handling dialog. For example, if you send a message to 10 different 
recipients and mark the message Priority in the Handling dialog, each of your recipients will receive a 
priority message, no matter what options may or may not be set for each individual recipient in their 
respective Recipient Handling dialogs.

· Recipient. The name or list you selected in the Draft window.

· Destination. The e-mail service that . To change the destination, click the Destination box and 
select an alternative from the pick list. 

· Address. The type of e-mail your recipient is currently slated to receive. To change the address, 
click the Address box and select an alternative from the list.



Sender Details Dialog
The Sender Details dialog appears when you select a message and click the Sender button on the 
Message window tool bar.    The dialog lets you view the sender's name and e-mail address, along with 
routing information about the message.

If you do not have the Auto Add to Address Book option selected in the Preferences Dialog (New Mail 
Tab), click the Add Address Entry button to add the sender's address to your Address Book.

Click View Address Entry to open the sender's Address Book Entry dialog;    i.e., their entry in your 
Address Book.



Advanced Messaging Dialogs and Features
Address Draft Dialog

Address Message Dialog

Attaching a File to a Message

Choose Name Dialog

Copying a Message

Deleting a Draft or a Message

Exporting a Message

Getting What You Want from Your Inbox Rules

Inbox Rule Dialog

Inbox Rule List Dialog

Mail Search Dialog

Message Attachments Dialog

Message Header Dialog

Message Status Icons

Moving a Message

Opening a File Attachment

Page Setup Dialog

Pasting from a Text File

Printer Setup Dialog

Printing a Message

Saving a Draft or a Message

Selecting a Message

Sending and Receiving Binary Files over the Internet

Sorting Inbox Mail



Address Draft Dialog
The Address Draft dialog appears when you click the Address button in a Draft window. The dialog lets 
you address a message by selecting your recipients from a pick list.

In the left column, E-Mail Connection lists every addressee to whom you have assigned a valid e-mail 
address. If your list is long, type your recipients name in the speed search box at the top. When E-Mail 
Connection selects your recipients name, double-click the selection or click the upper-most Add button. If 
your list is short, just scan the list and double-click your recipient, or select their name(s) and click Add.

Note that each click of the Add button places a name in the To list box on the right. This is where E-Mail 
Connection compiles your list of recipients.
Tip
The easiest way to compile your To:    and CC:    list(s) is to drag and drop your entries from one pick list to another.

If you add the wrong name, select the name in the To list box and click Remove. E-Mail Connection 
removes the name from the list of recipients. You will not delete anything permanently by clicking 
Remove. You only deselect the entry.

Repeat the procedure until your list of recipients is complete. When you are finished, click OK.



Address Message Dialog
The Address Message dialog appears when you click the Address button in a Draft window. The dialog 
lets you address a message by selecting your recipients from a pick list.

In the left column, E-Mail Connection lists every addressee to whom you have assigned a valid e-mail 
address. If your list is long, type your recipients name in the speed search box at the top. When E-Mail 
Connection selects your recipients name, double-click the selection or click the upper-most Add button. If 
your list is short, just scan the list and double-click your recipient, or select their name(s) and click Add.

Note that each click of the Add button places a name in the To list box on the right. This is where E-Mail 
Connection compiles your list of recipients.
Tip
The easiest way to compile your To:    and CC:    list(s) is to drag and drop your entries from one pick list to another.

If you add the wrong name, select the name in the To list box and click Remove. E-Mail Connection 
removes the name from the list of recipients. You will not delete anything permanently by clicking 
Remove. You only deselect the entry.

Repeat the procedure until your list of recipients is complete. When you are finished, click OK.



Attach File Dialog
The Attach File dialog appears when you click the Attach button on the Draft Window tool bar. The dialog 
lets you send a file to your recipient as an attachment to your message. There are no limitations on the 
types of files you send (i.e., .xls, .doc, etc.) However, you might want to ask your e-mail service about 
rates before you attach very large files.

The Attach File dialog displays a pick list of files on the selected drive. To filter out all files but compressed
files, select ZIP Files (*.ZIP) in the List Files of Type drop down list box.

1. Double-click the file you want to attach or select it and press Enter.

2. To attach multiple files, repeat the above steps as many times as necessary.

Each attachment appears as an application icon in the far right column of the Draft Window edit field.

Related Topic:
Sending and Receiving Binary Files over the Internet



Choose Name Dialog
The Choose Name dialog appears when E-Mail Connection finds more than one match to a name you 
have entered, and needs you to provide more information.

To select a recipient, type in his or her name in the Search box. As you type, E-Mail Connection 
dynamically selects the closest match from the Names list box. When you have typed in enough 
characters to uniquely identify your recipient (i.e., E-Mail Connection has selected your recipient) press 
Enter.



Copy Message Dialog
The Copy Message dialog appears when you select a message, and then select Copy in the Message 
menu.

To copy the active message, select a destination folder in the Copy Message dialog and click OK.



Deleting a Draft or a Message
To delete a draft or a message:

1. Click the Folders button (Easy Mode) or select New Folder Window in the Folder menu (Power 
Mode) and open the folder that contains the draft or message you want to delete.

2. Click once on the draft or message to highlight it.

3. Select Delete in the Message menu.

E-Mail Connection will ask you to confirm the deletion. See Delete Message Options under 
Preference's Confirmation Tab for more information.

4. Click the OK button to delete the draft or message.



Export Messages Dialog
The Export Messages dialog appears when you select Export Messages in the File menu. The dialog 
lets you archive the currently selected message to your hard disk. E-Mail Connection exports a message 
by formatting it as a DOS file and saving it to your hard disk. You can give the file any name and 
extension you want provided it is a valid DOS file name.

Type a name for the file in the Destination File Name box. The name must be a valid DOS file name.

Select a destination directory for the file in the Directories list box. The path of the default subdirectory is 
C:\EMC\TEMP.

Click OK.



Getting What You Want from Your Inbox Rules
Suppose you wanted E-Mail Connection to file all messages with the word Meeting in the message body 
to a folder called Boring only if the messages were from Fred.

To set up such an Inbox Rule, give the rule a name, then

Type: Fred in the Sender field.

Type: Meeting in the Message Text box.

Select: Boring from File Message in Folder box.

Now suppose you wanted E-Mail Connection to file all messages into the Boring folder that were either 
from Fred or had the word Meeting in the message body.

Setting up such an Inbox Rule is very different from the first one. For example, if you put both criteria in a 
single rule, all messages that were from Fred, but did not have the word meeting in the message body 
would not be filed in the Boring folder.

Instead, set up two Inbox Rules, one for Fred and one for Meetings. Select Boring as the destination 
folder in the File Message in Folder box for both Inbox Rules.

From that point forward, E-Mail Connection would file all messages into the Boring folder that were either
from Fred or had the word meeting in the message body.

In general, if your sorting criteria involve the word "and" (a message from Fred and about a meeting), use 
a single Inbox Rule. If your sorting criteria involve the word "or" (a message from Fred or about a 
meeting), use two or more Inbox Rules.



Inbox Rule Dialog
The Inbox Rule dialog appears when you click Add or Modify in the Inbox Rule List Dialog. The dialog 
lets you create or modify an Inbox Rule. Inbox Rules sort your Inbox mail into different folders or 
subfolders according to the parameter(s) you select in this dialog.

1. Rule Description. Give the Inbox Rule a descriptive name. For example, if the Inbox Rule will 
place all mail from Carl into a folder named Carl, you might want to type in Carl's Mail.
The name you assign to the template will appear in the Inbox Rule List dialog. Thus, if you give 
the template a descriptive name, later on, if and when you want to modify the template, it will be 
easy to find in the pick list.

2. File Message in Folder. Select a folder from the directory tree. E-Mail Connection will place all 
messages that satisfy this Inbox Rule, into the folder you select.

3. Choose one or more sorting rules that you want applied to Inbox mail. Refer to the table below for
a complete listing of the available sorting rules.
Select: To include in your template:

Source Only those messages from a specific E-Mail Service. Select 
All Sources to include messages from all E-Mail Services.

Any Sender Messages from any and all senders.

Any Unknown Sender Only those messages from senders not currently listed in 
your Address Book.

Any Known Sender Only those messages from senders currently listed in your 
Address Book.

A Specific Sender Only those messages from a sender you specify using the 
Sender button. See below.

Sender (button) Only those message from a sender you specify. Click the 
button to bring up a dialog that contains a pick list of 
addressees in your Address Book. Use the speed search box
or select the name from the pick list, then click OK.

Subject Only those messages with the same subject heading you 
type into the Subject box.

Message Text Only those messages with the same text you type into the 
Message Text box.

Attachment Only those messages sent to you with files attached to them.
DOS wild cards are okay. For example, to include only those 
messages with Excel spreadsheets attached to them, type in 
*.XLS.

Priority Only those messages sent Priority Mail.

4. Click OK. Click Cancel to exit the dialog without setting up an Inbox Rule.



Related Topics:
Getting What You Want from Your Inbox Rules
Promoting and Demoting Rules



Inbox Rule List Dialog
The Inbox Rule List dialog appears when you select Inbox Rules in the Folder menu. The dialog lets you 
create and manipulate your Inbox Rules - guidelines you set up to automatically sort your Inbox mail into 
different folders or sub-folders.

· Add. Create a new Inbox Rule that will sort your Inbox mail according to one or more specific 
parameters that you select in the Inbox Rule Dialog. The name you assign to your new Inbox 
Rule will appear in the Rule List.

· Modify. Change the Inbox Rule that is currently selected in the Rule List.

· Delete. Remove the Inbox Rule that is currently selected in the Rule List.

· Promote. When new mail arrives, E-Mail Connection looks down the Rule List. It starts at the top,
trying to match the message with the set of sorting rules outlined in the first Inbox Rule it finds. If 
the message and the Rule match, E-Mail Connection places the message in the folder you 
selected in the Inbox Rule dialog when you created the Rule. Otherwise, it goes on to the next 
Rule, and so on until all the mail has been distributed.
To move an Inbox Rule one step closer to the top of the Rule List, first select it, then click 
Promote. The selected Inbox Rule and the one above it exchange places.

· Demote. To move an Inbox Rule one step closer to the bottom of the Rule List, click Demote. 
The selected Inbox Rule and the one below it exchange places.



Mail Search Dialog
The Mail Search dialog appears when you click Search on the main window tool bar, press F10, or select 
Mail Search in the Folder menu. The dialog lets you search for messages and/or drafts in your E-Mail 
Connection message database.

Type in a name for the search in the Search Description field. E-Mail Connection uses the name you 
create to reference the search results later on if you want to modify the search parameters in the search 
template or view the resulting list of messages again.

If you select Search One Folder:

· Choose the folder you suspect contains the message(s)

· By default, E-Mail Connection selects Include Sub-Folders. Leave the option checked if you want 
the search to continue down the directory tree. Otherwise, toggle it off.

If you select Search All Folders:

· E-Mail Connection will search all folders for a match to any and all your criteria.

· Fill in as many of the available fields as possible. For the speediest, most efficient search, be as 
complete as you can be without sacrificing accuracy.

E-Mail Connection conducts searches from the Mail Search dialog using any combination of the following 
parameters:

Parameter Description

Source Select the E-Mail Service from which the message was sent.

Sender Enter the name of the person who sent the message you are looking for. Click the button
to bring up a dialog that contains a pick list of the addressees in your Address Book. 
Use the speed search box or select the name from the pick list, then click OK.

Recipient Enter the name of the person to whom you sent or will send the draft you are looking for.
Click the button to bring up a dialog that contains a pick list of the addressees in your 
Address Book. Use the speed search box or select the name from the pick list, then 
click OK.

Subject Enter the Subject Header, in whole or in part, from the message you want to find.

Message 
Text

Enter any string, in whole or in part, from the message you want to find. Note:    A search
for body text in a database full of messages can be very slow.

Attachment Enter the name of the file you have sent or received as a file attachment. DOS wild 
cards are okay. For example, to find any and all Excel spreadsheets attached to 
messages, use *.XLS.

Unread Only Toggles off and on. Prompts E-Mail Connection to search only those messages you 
have not yet read.

Priority Toggles off and on. Prompts E-Mail Connection to search only those messages sent to 
you Priority Mail.



Click OK only if you are ready for E-Mail Connection to begin the search.



Message Attachments Dialog
The Message Attachments dialog appears when you select Attachments in the Message menu, or click 
the Attachments button in a Message window (Power Mode only). The dialog lists the files (if any) 
attached to your message or draft.

There are three command buttons:

1. Attach. Opens the Attach File dialog, where you attach a file to your message.

2. Extract. Opens the Extract File dialog, where you separate the selected attachment from the 
message and save it as an independent file on your hard disk.

3. Delete. Removes the selected attachment from the message or draft.



Message Header Dialog
The Message Header dialog appears when you select Header in the Message menu. The dialog lets you 
view the full message header of the active message. Headers detail the names and addresses of all 
those who received the message, as well as other facts about the message you may want to know;    for 
example, what files were attached to it. Some messages may have detailed headers a page or more in 
length, particularly those sent via the Internet. Note that E-Mail Connection automatically displays the 
header's Date, Status, From, and Subject fields.



Message Status Icons

Heading Description
Status The type of message, indicated by the following icons.

! A Priority message.
A message that you have not yet read.
A message that you have read.
A message forwarded to you.
A working draft that you have saved, or a draft waiting in your Outbox.
A file attached to a message.

 From The name of the person who sent you the message.
Subject The subject of the message

Date The date the message was sent



Extract File Dialog
The Extract File dialog appears when you double-click a file attachment or click the Extract button in the 
Message Attachments dialog. The Extract File dialog lets you separate a file that is attached to an e-mail 
message and save it as an independent file so that you can view the file in its native application.

Under Destination File Name, E-Mail Connection writes the name of the file as it was sent to you. You 
can change the name to anything you want within the restrictions imposed by DOS.

Under Directories, E-Mail Connection selects TEMP as the default destination directory. TEMP is a 
subdirectory of the main E-Mail Connection directory.

At the bottom of the dialog, under Other Actions, you have two options.

· Delete file from message after extracting:    Click the option if you want E-Mail Connection to 
remove the attachment from the message once the file has been safely extracted.

· Launch file after extracting:    Click the option if you want E-Mail Connection to run the application 
capable of opening the file once the file has been safely extracted.

Select OK to extract the file. Select Cancel to exit the dialog without affecting any change.



Page Setup Dialog
The Page Setup dialog appears when you select Page Setup in the File menu. The dialog lets you 
control margins, headers, and footers when you print a message or a draft. By default, E-Mail Connection 
prints the date, time, and sender in the header. In the footer, it prints the page number, and the margins 
are set to 1/2 inch all around.

1. Header. Specify the contents and appearance of printed headers.
Use the Header/Footer Key at the top of the dialog as a quick reference guide.
For example, take a look at the default:
&L&D &CFrom:    &S &R&T
The resultant header has:

a. The date of the message left-justified on the page.

b. The word From:, followed by the sender's name in the center of the page.

c. The time of the message right-justified on the page.

2. Footer. Specify the contents and appearance of printed footers.
The default footer (Page &p) prints the word Page, followed by a number, on the left-hand side of
the page, at the bottom.

3. Left, Right, Top, Bottom. Set the left, right, top, and bottom margins on the printed page.

4. Click OK.



Paste From Text File Dialog
The Paste From Text File dialog lets you paste an ASCII text file into the active Draft Window, starting 
from the current cursor position. To open the dialog, select Paste From in the Edit menu.

The Paste From Text File dialog displays a pick list of files on the selected drive. To filter out all files but 
text files, select Text Files (*.TXT) in the List Files of Type drop down list box.

Double-click the file of your choice or select it and press Enter.



Printer Setup Dialog
The Printer Setup dialog appears when you select Printer Setup in the File menu. The dialog lets you 
modify the options you have set for your printer. 

1. Printer.
Select Default to use the printer you set as your default printer in Control Panel.
Select Specific Printer to choose an alternative from the pick list. The pick list will include only 
those printers for which you have loaded a valid printer driver in Control Panel.

2. Orientation.
Select Portrait to print your messages right-side-up on the page.
Select Landscape to print your messages sideways on the page.

3. Paper.
Size. Select the size you prefer from the pick list.
Source. Choose the location of the paper tray for automated form feed, or select an alternative 
manual-form-feed method.

4. Options. Specify dithering, intensity, and duplex settings.

5. Click OK.



Printing a Message
To print a message:

1. Select the message that you want to print from any Folder window.

2. Click the Print button.



Saving a Draft or a Message
Saving a draft:

· Click the Save button before you send the draft

· E-Mail Connection places saved drafts in the Draft folder.

Saving a message you send:

· By default, E-Mail Connection creates a copy of every message you send and stores it in the 
Sent Mail folder.

· To change the default, remove the check mark from Keep Copy under Preference's Drafts Tab.



Selecting a Message
E-Mail Connection uses folders to store your e-mail messages. Each folder window lists the status, 
sender, subject, and date for each message in that folder. Use any Folder window to select messages.

To select a message, just click the message one time.

A message is selected if it is highlighted.

Note    Selecting a message does not mean selecting the text of the message.



Sending and Receiving Binary Files Over the Internet
E-Mail Connection sends/receives binary file attachments using either MIME or 
UUENCODE/UUDECODE.    You do not have to do anything special to view the attachments you receive 
-- E-Mail Connection does all the work for you.    When you send a file attachment, ask your recipient 
which format they prefer (i.e., MIME or UUENCODE), then set the appropriate option when you configure 
Advanced Settings in the Internet Mail Setup Dialog.



Sorting Inbox Mail
You can instruct E-Mail Connection to move mail from your Inbox into specific folders by creating rules 
that specify where certain messages should be filed. By default, Inbox Rules are turned off in Easy Mode.
To enable Inbox Rules, select Preferences in the File menu, click the Display tab, and then check the 
Enable Inbox Rules box.

When new mail arrives in your Inbox and you click the File All Messages button, E-Mail Connection 
checks to see if the mail satisfies the set of rules outlined in the template. If so, it places the mail in the 
designated slot, i.e., the folder you specify in the template. If not, it checks the next template you have 
defined, and so on until it has distributed all your Inbox mail. If a message does not meet the 
requirements of your Inbox Rules, it remains in your Inbox until you move it to another folder or delete it.

If you only want E-Mail Connection to sort and file specific messages in your Inbox, just select them and 
click the File Selected Messages button.

For more information on defining Inbox Rules, see Inbox Rule List Dialog.



Common Questions about E-Mail Connection
Address Book
Attachments
Database
Error Messages
File Attachments
Folders
Installation
Internet
Messages
Passwords
Printing
Registration
Users
View Log / Transport Log
Winsock



Address Book

Is my Address Book stored in one specific file on my hard disk?

Is there a limit to how many addresses I can have in my address book?

Is there a way to print out my address book?



Q. Is my Address Book stored in one specific file on my hard disk?
A. No. E-Mail Connection stores the Address Book and Message database of each user in separate 
subdirectories. If you installed E-Mail Connection, your database is in a subdirectory called data0001. If 
you were the second person to configure E-Mail Connection , your database is in a subdirectory called 
data0002, and so on. 

There is no file that specifically contains just the Address Book. If you are trying to move your Address 
Book and Message database to another computer, please see Database. 

By the way, you should not delete or manipulate any of the files in the data000n subdirectories;    if you 
do, your database may become corrupted. 



Q. Is there a limit to how many addresses I can have in my address book?
A. There is a display limit of 2500 per Tab. You can actually add more than this but you cannot see more 
than 2500. They will be there but they appear as blank spaces. Note as well that there is a display limit of 
2500 messages in any folder (including the Inbox). In other words, if you have 2550 messages in your 
Inbox, you will not be able to see 50 of them until you move or delete 50 other messages. 



Q:    Is there a way to print out my address book?
A. Follow the steps below:

1. Click the Compose button.

2. Address the message to everyone in your address book whom you'd like to include in the 
printout.

3. Click Save.

4. Click Print.

5. Delete the message or save it for other printouts you may want to make in the future.



Attachments

When is a message sent as a file attachment?

How do I send an attachment from MS Word?

Does E-Mail Connection support MIME?

When can I successfully send an attachment (i.e. a binary file)?

Do I have to extract and save an attachment to a file in order to view it?

What is the difference between the Paste From command and the Attach command?

If I extract an attachment and make changes to it, will these changes be reflected in the 
original message?



Q. When is a message sent as a file attachment?
A. Any message over 30K. E-Mail Connection uses the basic windows edit controls which set the 30K 
limit. If you are concerned that your message is reaching the limit, take a look at the right-hand side of the
Draft window status bar - it displays the size of your message as you type. When you reach the 30K limit, 
the Draft window will not accept any new text. Note that many MAPI enabled applications give you the 
option to send all your files as attachments. For example in MS Word, select Options from the Tools 
menu, click General, then select Mail as Attachment.



Q. How do I send an attachment from MS Word?
A. Open the Tools menu, choose Options, click General, then select the Mail as Attachment option.



Q. Does E-Mail Connection support MIME?
A. Yes..



Q. When can I successfully send an attachment (i.e. a binary file)?
A. Attachments may be sent by anyone on the internet to anyone else on the Internet.

E-Mail Connection sends/receives binary file attachments using either MIME or 
UUENCODE/UUDECODE.    You do not have to do anything special to view the attachments you receive 
-- E-Mail Connection does all the work for you.    When you send a file attachment, ask your recipient 
which format they prefer (i.e., MIME or UUENCODE), then set the appropriate option when you configure 
Advanced Settings in the Internet Mail Setup Dialog.



Q. Do I have to extract and save an attachment to a file in order to view it?
A. Yes.



Q. What is the difference between the Paste From command and the Attach 
command?
A. The Paste From command lets you import an ASCII text file into your message. The Attach command
lets you send a binary file to your recipient. What that means is that your recipient receives a file that 
looks exactly the same as the one you have on your machine.



Q. If I extract an attachment and make changes to it, will the changes be reflected 
in the original message?
A. No. If you are editing a word processor document however, there is usually an easy way to make 
conditional changes to a file. For example, in MS Word open the Tools menu and choose Revisions. The
Revisions feature lets you make and save changes to a file without deleting the original information. After 
you make your revisions, send a message to the original sender and attach the revised file for approval.



Database

If I reinstall E-Mail Connection over itself will it erase my database?

Is there a way to compress my database?

I am getting Internal Database Errors.

How do I move my database (all folders with saved messages and complete Address 
Book) from one computer to another?

Can I erase my database and start over without reinstalling?

Every time I open E-Mail Connection it says that it cannot find the database. I click OK 
and everything seems fine.



Q. If I reinstall E-Mail Connection over itself will it erase my database?
A. No, the database will remain intact - your messages, saved drafts, and Address Book remain 
untouched.



Q. Is there a way to compress my database?
A. Run the Mailbox Update Utility. The utility is in the main E-Mail Connection directory and is called 
DBUTIL.EXE. 



Q. I am getting Internal Database Errors.
A. Assuming you have not altered or deleted any files in the database subdirectories (data0001, 
data0002, etc.), the Mailbox Update Utility should cure any problems. The utility is in the main E-Mail 
Connection directory and is called DBUTIL.EXE.

If the Update utility does not solve your problem, run the DOS Scan Disk utility (or a similar utility) to 
check for bad sectors or bad clusters. If Scan Disk does not solve the problem, run the DOS Defrag utility 
(full optimization) to defragment your hard drive.



Q. How do I move my database (all folders with saved messages and complete 
Address Book) from one computer to another?
A. First, do not alter any file in the database subdirectories (i.e., data0001, data0002, etc.). Altering the 
files could cause an internal database error, permanently damaging your database.

Note that the steps below detail how to move one and only one user database, and assumes the user 
data resides in the data0001 subdirectory. If you were the second user to configure E-Mail Connection, 
your data subdirectory is called data0002.

1. On the old computer create a temporary directory named ORIGDB.

2. Copy all the files in the data0001 directory into it to keep as a backup.

3. Copy all the data0001 files to either disk or up onto your Network (you may want to zip the files 
first). If the database is large, using the pkzip utility with the command pkzip -& db.zip will span 
the files across a number of disks.

4. Install E-Mail Connection on the new machine.

5. When the New User Information dialog appears, click Cancel to create your data0001 directory. 
Delete all the files within the data0001 directory on the new machine and replace them with the 
data0001 files from the old computer.



Q. Can I erase my database and start over without reinstalling?
A. Yes. Assuming you are the only user, delete the data0001 directory and the EMCMAIN.INI (located in 
the E-Mail Connection directory), and restart Windows. Open E-Mail Connection. You create a brand new 
database when you reenter all your user information.



Q. Every time I open E-Mail Connection it says that it cannot find the database. I 
click OK and everything seems fine.
A. You have probably deleted a user, and E-Mail Connection is still looking for the associated database 
on startup. When you choose OK it looks and finds your other, current database, and continues normally. 
You should open EMCMAIN.INI, set NumProfiles = 1, and delete the second user.



Error Messages
Error Messages that may appear when you write a message
Internet Error Messages



Error Messages that may appear when you write a message
Error Message:    
System error -901 (may be followed by other errors)

When the message appears:    
Composing a message.

Solution:    
You are running out of disk space.



Folders

Is there a limit to how many folders I can have?



Q. Is there a limit to how many folders I can have?
A. The limit is 2500 folders, with 2500 messages in each one.



Installation

How do I move E-Mail Connection to another drive?

Where do I enter the phone number for an Internet SLIP and/or PPP connection?

If I reinstall E-Mail Connection over itself will it erase my database?



Q. How do I move E-Mail Connection to another drive?
A. Follow the steps below:

1. Create the new directory and its sub-directories on the new drive. 

2. Copy all of the corresponding files into each directory.

3. Rename your old directory EMC_OLD.

4. In your new E-Mail Connection subdirectory, double-click EMCMAIN.INI and change the line that 
reads:    1=(path to original location)_ to the path to the new location.

5. Switch to Program Manager and select the E-Mail Connection icon

6. Open the File menu and select Properties.

7. Edit the command line and the working directory to reflect the new path to the executable files.



Q. Where do I enter the phone number for an Internet SLIP and/or PPP 
connection?

A. In order to use the Internet driver in E-Mail Connection, you need to install a stack that lets you 
communicate with your Internet host. When you set up and configure your stack, you enter the phone 
number to your Internet host in a script file that handles all of your dial-outs. E-Mail Connection assumes 
you are already connected to your Internet host when you attempt to download or upload your e-mail.



Internet

Where do I enter the phone number for an Internet SLIP and/or PPP connection?

Internet Error Messages



Internet Error Messages
Error Message:
Socket error. This may be a problem with your TCP/IP network software.

When the message appears:
You are trying to connect to your Internet host.

Solution:    
Exit windows, then reopen

Error Message:    
wsa get last error = 11004

When the message appears:    
Trying to connect to the Internet.

Solution:    
Your stack must first connect to your Internet host before E-Mail Connection can download your Internet 
mail.

Error Message:    
Cannot find remote.dll.

When the message appears:    
Trying to connect to the Internet.

Solution:    
Your stack must first connect to your Internet host before E-Mail Connection can download your Internet 
mail.

Error Message(s):    
Internet System Error. This may be a problem with your configuration. 
OR
Internet initialization error, unable to load winsock.dll, may be a problem with configuration.
OR
Winsock load failure. This may be a problem with your TCP/IP network.

When the message appears:    
Scanning for Internet Mail.

Solution:    
Search for WINSOCK.DLL on your hard drive. If your search engine finds two or more such files, E-Mail 
Connection is probably finding the incorrect one first and trying to use it. Rename one of the files 
WINSOCK.OLD and try again. If you get the same error, change the name back to WINSOCK.DLL and 
rename the second .DLL file to WINSOCK.OLD. When you find the correct version of WINSOCK.DLL, 
adjust the PATH statement in your AUTOEXEC.BAT file so that the correct WINDSOCK.DLL is listed first.

Error Message:    
Internet System Error, see view log. Failure, may be problem with TCP/IP network software. May be 
problem with Internet configuration.

When the message appears:    
After you click the Internet Connect button.

Solution:    



Open the Internet configuration dialog and make sure the information in the dialog is correct, especially 
the name of your Mail Server. If you have any doubts about any of the information, ask your Internet 
provider to verify it for you. Click the More button and check that the defaults are set. These are only 
changed in rare circumstances. Re-try.



Messages

Does E-Mail Connection include archived messages in a search?

Is it possible to address a message to a Personal List and have each recipient see only 
his or her name in the header?

Is there a Send Only option in E-Mail Connection?

What is the largest message I can send?

Why would I queue a message to be sent rather than simply sending it?

How many messages can I store in a folder?



Q. Does E-Mail Connection include archived messages in a search?
A. No. Archiving (Export Message) moves messages to the hard drive.



Q. Is it possible to address a message to a Personal List and have each recipient 
see only his or her name in the header?

A. This is not possible with a Personal List.



Q. Is there a Send Only option in E-Mail Connection?
A. For modem-based e-mail services:    

1. If you use the Scheduler, open your mail system configuration dialog and click the Schedule 
button. Choose Notify Before Manual Connections, then click OK.

2. If you do not use the Scheduler, note the dialog that appears when you click the Connect button. 
Make sure the Receive Incoming Messages option at the bottom of the dialog is deselected 
before you log on to your e-mail service.

For LAN e-mail services, there is no way to only send mail.



Q. What is the largest message I can send?
A. 30K without file attachments;    2MB or more with file attachments. The upper limit on the size of a 
message depends more upon your Internet provider than E-Mail Connection.



Q. Why would I queue a message to be sent rather than simply sending it?
A. If you need to dial up the service for access (as opposed to having a constant connection through your 
LAN), you would have to pause any work you are currently doing on the computer until the process of 
sending/receiving mail is done. If you are in the middle of something when the scheduler alert appears 
you may pause the connection until you are ready. 

Finally, some users like to proof their messages one last time in the Outbox before they transmit the 
message to their recipients.



Q. How many messages can I store in a folder?
A. There is a display limit of 2500 messages in any folder (including the Inbox). In other words, if you 
have 2550 messages in your Inbox, you will not be able to see 50 of them until you move or delete 50 
other messages.



Q. Do the contents of a message have to be sent as ASCII text?
A. Anything in the body of the message must be ASCII text;    if you want to send formatted text, graphics,
spreadsheets, etc., you must be send it as a binary file attachment.



Passwords

How many characters may my password have?



Q. How many characters may my password have?
A. There is no limit.



Printing

Can I print just the body text of a message (i.e., exclude the header)?

I have changed my document font but it always prints using the default font.



Q. Can I print just the body text of a message (i.e., exclude the header)?
A. No. But an attachment would print with no header.



Q. I have changed my document font but it always prints using the default font.
A. Changing the document font affects only your screen view. Printing from E-Mail Connection will 
always use the default font.



Registration Questions

I didnt receive a registration card with my E-Mail Connection.



Q. I didnt receive a registration card with my E-Mail Connection.
A. Please see online registration.



Users

In my office we have six co-workers using one computer to access our mail. When I 
change to a different user the database shown is still mine.

How many users can use one copy of E-Mail Connection?

We have multiple users set up on one computer, but I cannot seem to access the other 
peoples address books.



Q. In my office we have six co-workers using one computer to access our mail. 
When I change to a different user the database shown is still mine.
A. Each user has a separate and distinct Message and Address Book database. You need to exit E-Mail 
Connection, then start it up again and log in with the different users name and Password.



Q. How many users can use one copy of E-Mail Connection?
A. The only limit is the amount of hard disk space you have available for multiple Message and Address 
Book databases.



Q. We have multiple users set up on one computer, but I cannot seem to access 
the other peoples address books.
A. Each user has a separate and distinct Message and Address Book database. You need to exit E-Mail 
Connection, then start it up again and log in with the different users name and Password.



View Log

How do I clear the View Log?



Q. How do I clear the View Log?
A. The View Log/Transport Log purges itself automatically when it reaches 16K. It is also cleared when 
you run the Mailbox Update Utility (DBUTIL.EXE).



Winsock

What is WinSock?

What mail protocol does E-Mail Connection support?

Do I need to have the WINSOCK.DLL in the E-Mail Connection directory?





Q. What is WinSock?
A. WinSock is a standard developed by Microsoft and other Internet developers that provides a common 
programming interface between Internet applications and internal system network (or operating system) 
software. Vendors supply the WinSock functions in a module called WINSOCK.DLL. All WINSOCK.DLLs 
provide the same standard set of services, but are structured differently, depending on the vendor and the
system that the .DLL was written for.

For PC users, WinSock implementations provide TCP (Transmission Control Protocol - network), or SLIP 
(Serial Link Internet Protocol - dialup), or PPP (Point-to-Point) connections.

Where do I find WinSock.dll?

There are several shareware WinSock.dll's on the Internet and in the libraries of many online services.



Q. What mail protocol does E-Mail Connection support?
A. SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol), a fairly universal protocol on the 
Internet. As long as the machine we are talking to understands SMTP/POP, it does not matter what 
operating system it is running;    UNIX, VMS, etc.



Q. Do I need to have the WINSOCK.DLL in the E-Mail Connection directory?
A. No. But you need to have the path to the correct WINSOCK.DLL (if you have more than one in your 
hard drive) in your AUTOEXEC.BAT file. In some cases, WinSock needs to be in the same directory as 
your stack software.



Glossary of Terms
Asynchronous Server
Distribution List
E-Mail Service
E-Mail System
Extract
Inbox
LAN
Launch
Network
Outbox
Personal Mailing List
Protocol



Asynchronous Server
Any dial-up server. Examples of asynchronous servers include MCI Mail, CompuServe, and PRODIGY.



Distribution List
A special name you assign a list of recipients who share a common interest. Distribution Lists, like 
Personal Mailing Lists, provide you with a simple way to address mail to a group of two or more 
recipients. Distribution Lists are maintained by an e-mail system.



E-Mail Service
Generic term used to refer to the global set of e-mail providers or vendors E-Mail Connection can access 
directly or indirectly. E-Mail Systems are a subset of e-mail services. See E-Mail System.



E-Mail System
Refers to the first e-mail service that transmits a message you send. In other words, messages you send 
originate from e-mail systems.



Extract
To separate a file that is attached to an e-mail message and save it as an independent file.



Inbox
The window in which E-Mail Connection puts any e-mail messages you receive. Serves as the delivery 
hub, the distribution center from which you file your messages into specific folders.



LAN
Local Area Network. A network structured to serve a small area such as a building or group of buildings.



Launch
To activate an application that can open a file specifically formatted to run under that application. For 
example, if you receive an Excel spreadsheet as an attachment to an e-mail message, E-Mail Connection
will start up Excel, which in turn will open the file.



Network
A combination of hardware and software that allows computers to share files and to communicate with 
one another.



Outbox
The window in which E-Mail Connection holds your e-mail messages waiting to be sent. E-Mail 
Connection temporarily places your outgoing mail into there until you are actively connected to a network 
or an e-mail service that can properly route your message to its destination.



Personal Mailing List
A special name you assign to a list of recipients who share a common interest. Personal Mailing Lists, like
Distribution Lists, provide you with a simple way to address mail to a group of two or more recipients. 
Personal Mailing Lists are maintained by E-Mail Connection.



Protocol
A set of rules or specifications that dictate how hardware or software should operate.
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